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Préface

1. À propos de Mandriva Linux

Mandriva Linux est une distribution GNU/Linux développée par Mandriva S.A. La société Mandriva est née sur In-
ternet en 1998 ; son ambition première demeure de fournir un système GNU/Linux convivial et facile à utiliser.
Les deux piliers de Mandriva sont le logiciel libre et le travail collaboratif.

Note : Le 7 avril 2005, la société Mandrakesoft a modifié son nom pour refléter sa fusion avec Conectiva, leader
GNU/Linux du Brésil. Par conséquent, le produit phare Mandrakelinux a lui aussi changé de nom pour Mandriva Linux.

1.1. Communiquer avec la communauté Mandriva Linux

Nous présentons ci-dessous plusieurs liens Internet pointant vers les ressources liées à Mandriva Linux les
plus importantes. Si vous souhaitez en savoir plus sur la société Mandriva, consultez le site Web de Mandriva
(http://www.mandriva.com/). Vous pouvez aussi visiter le site dédié à la distribution Mandriva Linux (http:
//www.mandriva.com/linux) et à tous ses dérivés.

Mandriva Expert (http://www.expert.mandriva.com/) est la plate-forme d’aide en ligne de Mandriva. Elle
propose une nouvelle façon de partager les savoirs, basée sur la confiance et le plaisir de récompenser son
prochain pour son aide.

Vous êtes également invité à participer aux nombreuses listes de diffusion (http://www.mandriva.com/fr/
mailing_lists), où la communauté Mandriva Linux déploie tout son enthousiasme et sa vivacité.

Enfin, n’oubliez pas de vous connecter sur la page sécurité (http://www.mandriva.com/security/) (en an-
glais). Ce site rassemble tout ce qui traite de la sécurité des distributions Mandriva Linux. Vous y trouverez
notamment des avertissements de bogues et de sécurité, ainsi que des procédures de mise à jour du noyau,
les différentes listes de diffusion concernant la sécurité auxquelles vous pouvez souscrire et Mandriva Online
(https://online.mandriva.com/). Ce site est incontournable pour tout administrateur système ou tout utili-
sateur soucieux de sécurité.

1.2. Rejoignez le Club

Mandriva Club est l’espace de rencontre où les utilisateurs se retrouvent pour s’entraider, échanger de pré-
cieuses informations sur Mandriva Linux, s’informer des dernières nouvelles concernant Mandriva, Linux et
l’Open Source. Les membres du Club ont un accès privilégié à une gamme de services plus étendue.

Grâce à votre identifiant Mandriva (obtenu gratuitement en vous inscrivant sur My Mandriva (https://my.
mandriva.com/register)), vous bénéficiez :

• d’aide (forums, chat, Base de Connaissance contenant des tutoriels, des mini-guides, des trucs et astuces) ;

• d’actualités ;

• et de plus de contenus conçus par Mandriva et la communauté.

En tant que membre du Club, vous accédez en exclusivité à :

• 50 000 paquetages RPM, y compris des logiciels commercialisés, des pilotes, des démos... ;

• des serveurs de téléchargement ultra rapides ;

• la documentation officielle de Mandriva Linux ;

• l’accès à des services en ligne donnés par des experts, ainsi que des formations par Internet (eTraining) ;

• des réductions spéciales en permanence au Mandriva Store ;

• ... et bien plus encore !

C’est au Club Mandriva que vous pouvez faire l’expérience la plus enrichissante de Mandriva Linux : en
apprenant des autres, en montrant aux autres, en accédant à des fonctionnalités exclusives et en contribuant
au développement de Mandriva Linux et de l’Open Source en général.

1

http://www.mandriva.com/
http://www.mandriva.com/linux
http://www.mandriva.com/linux
http://www.expert.mandriva.com/
http://www.mandriva.com/fr/mailing_lists
http://www.mandriva.com/fr/mailing_lists
http://www.mandriva.com/security/
https://online.mandriva.com/
https://my.mandriva.com/register
https://my.mandriva.com/register


Préface

1.3. Acquérir des produits Mandriva

Vous pouvez acheter des produits Mandriva en ligne sur le Mandriva Store (http://store.mandriva.com).
Vous y trouverez non seulement des solutions Mandriva Linux, des systèmes d’exploitation et des CD de dé-
marrage « live » (comme MandrivaOne), mais aussi des offres spéciales d’abonnement, de l’assistance, des
logiciels tiers, des manuels et des livres GNU/Linux, ainsi que d’autres gadgets Mandriva.

Nous ne pourrions pas clore cette section sans mentionner la dernière innovation de Mandriva. Mandriva Flash
est une distribution Mandriva Linux préinstallée qui tient sur une clé USB 2.0 de 2 giga-octets. Vous n’avez
qu’à insérer la clé dans votre ordinateur pour démarrer votre système Linux n’importe où. Vous pouvez aussi
sauvegarder et échanger des données sur la clé grâce à l’espace libre de 10 giga-octets.

1.4. Contribuer à Mandriva Linux

Quels que soient vos talents, vous êtes encouragé à participer à l’une des nombreuses tâches requises à la
construction du système Mandriva Linux.

• Paquetages. Un système GNU/Linux est principalement constitué de programmes rassemblés depuis Inter-
net. Ils sont mis en forme de façon à fonctionner ensemble.

• Programmation. Une foule de projets est directement développée par Mandriva : trouvez celui qui vous
intéresse le plus et proposez votre aide au développeur principal.

• Internationalisation. Vous pouvez nous aider à traduire les pages de nos sites Web, les programmes et leur
documentation respective.

Consultez la page des projets de développement (http://qa.mandriva.com/wiki) pour en savoir plus sur les
différentes façons de contribuer à l’évolution de Mandriva Linux.

2. À propos de ce mini-guide d’installation

Le but de ce guide est de vous présenter les fonctionnalités uniques de Mandriva One, et d’une manière
générale, de vous aider à utiliser et administrer votre système. Que vous soyez un nouvel utilisateur de Linux
ou un utilisateur expérimenté, vous trouverez ici des informations utiles pour maîtriser complètement votre
système.

Démarrez votre système. Votre produit est un CD ou DVD « live », c’est-à-dire, que vous pouvez l’utiliser
directement sans avoir à l’installer sur votre ordinateur. Nous allons donc vous guider dans les quelques
étapes préliminaires nécessaires pour mettre en place votre système.

Utilisez votre système. Si vous êtes un nouvel utilisateur de Linux, vous vous sentirez peut-être comme un
étranger dans un nouveau pays. Nous allons vous guider dans votre nouvel environnement et vous vous
sentirez bientôt chez vous.

Profitez de vos périphériques. Vous voulez utiliser votre imprimante, votre scanner, ou votre webcam ? Rien
de plus facile ! Mandriva Linux supporte la plupart des périphériques et propose d’excellentes applications
pour en profiter au maximum.

Détendez-vous. Mandriva Linux n’est pas seulement fait pour travailler ! Elle offre une gamme complète de
jeux pour tous les goûts. Nous avons sélectionné les meilleurs pour vous.

Installez votre système et partagez-le avec vos amis. Vous allez vite adopter Mandriva Linux et vous l’utiliserez
plus souvent que vous ne le pensez. Nous vous montrons comment l’installer sur votre disque dur pour de
meilleures performances, et comment en faire facilement des copies pour vos amis et vos proches.

3. Démarrage du CD Live MandrivaOne

MandrivaOne vous permet d’utiliser un système Mandriva Linux entièrement fonctionnel, avec des outils bu-
reautiques, Internet, multimédia et même des jeux, à partir du CD ou DVD sans avoir à installer quoi que ce
soit sur votre ordinateur : tous les logiciels s’exécutent depuis le média.
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Vous pouvez utilisez MandrivaOne pour essayer Mandriva Linux avant de l’installer, pour travailler sans « tou-
cher » au système d’exploitation déjà installé sur l’ordinateur ni à vos fichiers, ou encore pour réparer un
système endommagé.

Veuillez consulter Partagez et installez votre système Linux, page 35 pour plus de renseignements.

3.1. Démarrage du CD

Assurez-vous que votre ordinateur est configuré pour démarrer à partir du lecteur de CD-ROM, insérez le CD
de MandrivaOne et redémarrez l’ordinateur. Veuillez-vous reporter à la documentation de votre ordinateur si
vous avez besoin de plus d’informations pour configurer le démarrage à partir du CD-ROM.

Quelques paramètres (langue, pays, configuration du clavier, fuseau horaire, etc.) doivent être configurés à
chaque démarrage. Il vous suffit de sélectionner vos préférences dans la liste proposée. Veuillez noter que :

• si vous sélectionnez l’option Je refuse, des conditions d’utilisation de la licence, vous ne pourrez pas utiliser
MandrivaOne, et l’ordinateur s’éteindra quand vous cliquerez Quitter ;.

• après avoir sélectionné le fuseau horaire, vous devez indiquer si votre horloge système est réglée sur l’heure
UTC (Temps Universel Coordonné). En cas de doute, répondez Non.

3.2. Mots de passe par défaut

La distribution « Live » est configurée de telle sorte que ni l’utilisateur par défaut (guest), ni l’administrateur
(root) n’ont de mot de passe. Donc, pour la plupart des manipulations, aucun mot de passe ne vous sera
demandé, mais si cela arrivait, laissez-les vides, c’est-à-dire : appuyez simplement sur Entrée.
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Chapitre 1. Utiliser Internet

MandrivaOne est un excellent outil pour utiliser Internet. Dans cette section, nous vous montrons comment
gérer vos courriers électroniques avec KMail, naviguer sur le Web avec Konqueror, et discuter avec vos amis et
collègues par l’entremise de Kopete.

1.1. Envoyer et recevoir du courrier électronique

À partir du menu principal, choisissez Internet→Logiciel de messagerie électronique pour lancer KMail.
Un assistant de configuration apparaît alors.

1.1.1. Configuration de la messagerie électronique

Figure 1-1. Type de compte

Sélectionnez le type de compte de messagerie dans la liste et allez à l’étape suivante. La configuration des
comptes IMAP et POP3 est identique.

Figure 1-2. Informations sur le compte

Veuillez entrer votre nom, votre adresse électronique et le nom de votre société.
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Chapitre 1. Utiliser Internet

Figure 1-3. Informations sur le compte

Entrez votre identifiant de messagerie ainsi que le mot de passe associé. Votre FAI ou votre administrateur
système a dû vous fournir ces informations en même temps que votre adresse e-mail.

Figure 1-4. Serveurs de courriers

Enfin, vous devez fournir les paramètres de serveur de courrier. Encore une fois, votre FAI ou votre ad-
ministrateur système a dû vous fournir les noms des serveurs de courrier entrant et sortant. Le nom
du serveur pour l’envoi des courriers est généralement de la forme smtp.fournisseur.net. Pour
la réception, les serveurs POP3 ont généralement un nom de la forme pop.fournisseur.net ou
pop3.fournisseur.net. Quant aux serveurs IMAP pour la réception du courrier, ils sont généralement
de la forme imap.fournisseur.net. La forme mail.fournisseur.net est aussi courante pour les ser-
veurs de courrier entrant et sortant.
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Chapitre 1. Utiliser Internet

1.1.2. Interface du client de messagerie

Liste des dossiers

Barre d’outils

Liste de messages

Volet des
messages

Figure 1-5. Interface de KMail

Barre d’outils. Les boutons associés aux actions principales se trouvent ici. Voir tableau 1-1.

Liste de messages. Les informations (sujet, date, expéditeur, etc.) au sujet des messages stockés dans le dossier
actuellement sélectionné sont affichées à cet endroit.

Volet des messages. Le contenu du message sélectionné s’y affiche.

Liste des dossiers. Tous vos dossiers y sont énumérés. Les dossiers par défaut sont Boîte de réception
(messages entrants), Boîte d’envoi (messages en attente d’envoi), Messages envoyés (messages déjà
envoyés), Corbeille (messages effacés), ainsi que Brouillons et templates (modèles de message
avec quelques champs déjà remplis). Un répertoire spécial nommé Recherches contient les résultats des
recherches effectuées.

1.1.3. Utilisation de KMail

Le tableau suivant montre et décrit les boutons les plus importants qui sont disponibles dans la barre d’outils
de KMail. Il mentionne également leurs raccourcis clavier respectifs et explique leurs fonctions.

Bouton Raccourci clavier Fonction

Ctrl-N Composer un nouveau message. Vous devez remplir les champs À
et Objet dans la fenêtre de rédaction de message.

Ctrl-L

Récupérer les messages pour tous les comptes de courrier définis.
Si vous maintenez ce bouton enfoncé, une liste de tous vos
comptes sera affichée. Sélectionnez celui pour lequel vous désirez
uniquement récupérer les messages.

R Répondre à l’auteur du message sélectionné. Une fenêtre de
composition s’affichera. Quelques champs seront déjà remplis.

F Transmettre (envoyer à un tiers) le message sélectionné.
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Chapitre 1. Utiliser Internet

Bouton Raccourci clavier Fonction

Del

Effacer les messages sélectionnés. Les messages effacés seront
déplacés dans le dossier Corbeille. Vous pouvez récupérer ces
messages, mais il est impossible de récupérer les messages qui
auront été effacés depuis la Corbeille : faites attention !

Tableau 1-1. Boutons de la barre d’outils de KMail

Note : Certains de ces boutons sont munis d’une petite flèche située en bas à droite. Elle indique qu’un menu abritant
des actions supplémentaires peut être affiché en cliquant sur le bouton de la souris un peu plus longtemps.

1.2. Naviguer sur Internet

Choisissez Internet→Navigateur Web dans le menu principal pour lancer Konqueror. La page d’accueil
s’affiche alors. Ensuite, tapez une adresse Internet dans la barre d’adresse, nommée Emplacement.

1.2.1. Interface du navigateur Web

Barre d’outils

Barre d’adresse

Zone
d’affichage

Barre de
signets

Onglets de
navigation

Figure 1-6. Interface de Konqueror

Barre d’outils. Où se trouvent les boutons vous permettant de naviguer et d’accomplir les tâches communes
(voir tableau 1-2).

Barre d’adresse. Où vous saisissez les adresses des sites ou des fichiers locaux, en remplaçant http:// par
file:// en début d’URL.

Barre de signets. Où se trouvent les boutons qui vous permettent d’accéder rapidement à vos sites favoris.

Navigation par onglets. Vous permet de consulter plusieurs sites dans la même fenêtre au lieu d’en ouvrir
plusieurs, ce qui rend la navigation bien plus aisée.

Zone d’affichage. Où s’affiche le contenu de la page Web ou des fichiers locaux que vous voulez consulter.
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1.2.2. Naviguer sur le Web

Bouton Raccourcis clavier Fonction

Alt-flèche gauche
Précédent. Retourne à la page affichée avant celle actuellement
visitée. Gardez le bouton enfoncé pour afficher la liste des pages
visitées précédemment.

Alt-flèche droite
Suivant. Retourne à la page que vous avez visitée après celle
actuellement visible. Les mêmes considérations que celles
exposées pour le bouton « Précédent » s’appliquent.

F5

Recharger. Actualise la page en cours. Par défaut, Konqueror utilise
la page disponible dans son cache (espace disque temporaire).
Appuyez sur la touche Shift lorsque vous cliquez sur ce bouton
pour forcer Konqueror à récupérer la page depuis Internet.

Esc Arrêter. Arrête le transfert des objets demandés et, par la même
occasion, annulera le chargement de la page demandée.

Tableau 1-2. Boutons de la barre d’outils de Konqueror

Le navigateur Web Konqueror vous permet de consulter de nombreuses pages Web dans la même fenêtre en
utilisant une fonctionnalité nommée « navigation par onglets ».

Cliquez sur ce bouton (ou Ctrl-Shift-N) pour créer et ouvrir un nouvel onglet. Entrez une adresse Inter-
net dans la barre d’adresse pour visualiser la page dans le nouvel onglet.

Astuce : Vous pouvez également taper Ctrl-Shift-D pour dupliquer l’onglet courant, c’est-à-dire ouvrir la même page
sur laquelle vous êtes, mais dans un nouvel onglet. Ceci est pratique pour les pages très longues vous permettant ainsi
de lire en même temps deux sections différentes d’une même page.

Ferme l’onglet actuellement affiché (Ctrl-W).

Pour retrouver vos sites favoris où que vous soyez, il est recommandé d’utiliser des sites de marque-pages
mutualisés (social bookmarking en anglais) comme Del.Icio.Us (http://del.icio.us), par exemple.

1.3. Discuter avec des amis ou collègues

Sélectionnez Internet→Messagerie instantanée à partir du menu principal pour lancer Kopete. Un as-
sistant de configuration apparaît.

9
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Chapitre 1. Utiliser Internet

1.3.1. Configurer Kopete

Figure 1-7. Sélection du service de messagerie

Avec Kopete, vous pouvez discuter avec des personnes qui utilisent MSN, Yahoo, ICQ, IRC, etc. Choisissez un
des services de messagerie dans la liste et passez à l’étape suivante. Gardez en tête que chaque service de mes-
sagerie possède ses propres paramètres de configuration. Dans cette section, nous vous montrons comment
configurer une service de messagerie instantanée, ainsi qu’un compte IRC.
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Figure 1-8. Informations sur le compte

Vous devez fournir des informations sur le compte : au minimum un identifiant (ou une adresse électronique)
et un mot de passe, mais certains services peuvent nécessiter plus d’informations. Référez-vous à la documen-
tation de votre service de messagerie instantanée pour obtenir plus de renseignements sur les paramètres de
connexion à remplir.

Astuce : La plupart des services de messagerie propose un bouton Créer un nouveau compte vous permettant d’obtenir
un nouveau compte de ce service.

Le dernier écran de l’assistant vous invite à vous connecter au service de messagerie. Décochez la case Connec-
ter maintenant si vous désirez vous connecter plus tard.

Choisissez Configuration→Configurer dans le menu, puis sélectionnez la section Comptes et cliquez sur le bouton
Nouveau pour configurer un nouveau compte de messagerie. Nous allons maintenant ajouter un compte pour
le serveur IRC irc.freenode.net et le canal de discussion #mandrivafr, où vous trouverez de l’aide pour
votre système MandrivaOne par l’entremise d’autres utilisateurs de Mandriva Linux.
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Figure 1-9. Configuration IRC de base

Entrez un pseudonyme 1 ainsi qu’un pseudonyme alternatif, au cas où quelqu’un aurait déjà enregistré celui
que vous avez choisi. Si vous le désirez, vous pouvez ajouter un nom d’utilisateur et un mot de passe.

Astuce : Généralement, le pseudonyme alternatif est le même pseudonyme auquel on ajoute un _.

Figure 1-10. Paramètres de serveur IRC

1. Dans les canaux de discussions IRC, votre identifiant est le pseudonyme que vous avez choisi.
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Ensuite, choisissez l’onglet Connexion et sélectionnez un serveur IRC dans la liste déroulante Réseau. Vous
pouvez également choisir le jeu de caractères par défaut ainsi que d’autres options. Passez à l’étape finale et
quittez l’assistant.

1.3.2. Interface de Kopete

Liste de contacts

Barre d’outils

Services
Figure 1-11. Interface de messagerie instantanée

Barre d’outils. Les principaux boutons d’action s’y trouvent. Voir tableau 1-3.

Liste de contacts. Chacun de vos contacts y possède une entrée spécifique et une icône indiquant le protocole
utilisé. L’état de vos contacts est indiqué de cette manière :

•

Le contact est connecté et disponible.

•

Le contact est connecté mais non disponible. Selon le protocole utilisé, vous pouvez quand même lui envoyer
des messages qu’il lira lorsqu’il sera à nouveau disponible.

•

Le contact n’est pas connecté, vous ne pouvez pas lui envoyer de messages. Remarquez que vous ne pouvez
voir ce statut que si vous avez choisi d’afficher les contacts non connectés.

État des services. Chaque service de messagerie configuré possède une icône. Si cette icône est colorée, cela
signifie que vous êtes connecté au service. Sinon, il apparaît en gris. Faites un clic droit sur une icône pour
obtenir un menu spécifique au service de messagerie choisi.
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Bouton Fonction

1.3.3. Discuter avec Kopete

Bouton Fonction

Régler l’état. Affiche une liste de tous les états possibles lorsque vous êtes connecté.
Choisissez celui que vous désirez dans la liste. Gardez à l’esprit que l’état sera appliqué à
tous vos services de messagerie configurés.

Ajouter un contact. Choisissez le service de messagerie dans la liste, puis entrez
l’identifiant de votre contact. Vous pouvez également l’assigner à un groupe. Cliquez sur
OK pour l’ajouter à votre liste.
Les services de messagerie les plus populaires, comme MSN, Yahoo, ICQ, et Jabber, en-
registrent la liste de vos contacts sur leur serveur. Par conséquent, vous conservez votre
liste de contacts, où que vous soyez.

Quand vous cliquez sur ce bouton, les utilisateurs non connectés apparaissent dans votre
liste. Cette option est pratique pour visualiser tous les contacts de votre liste selon le
service de messagerie utilisé.

Tableau 1-3. Boutons de la barre d’outils de Kopete

Pour commencer une discussion avec un de vos contacts, double-cliquez simplement sur son nom dans la liste.
Une fenêtre divisée en deux apparaît. Dans la partie inférieure, tapez votre texte, la conversation s’affichera
dans la partie supérieure.

Le protocole IRC est un peu différent. Vous devez d’abord rejoindre un canal de discussion sur un serveur. Un
canal est une salle de discussion avec un sujet spécifique. Pour rejoindre un canal :

1. Cliquez sur l’icône d’état IRC.

2. Choisissez l’entrée Rejoindre un canal.

3. Tapez le nom du canal dans la boîte de dialogue. Les noms de canaux commencent par un dièse (#). Par
exemple : #mandrivafr.

4. Une fenêtre similaire aux autres services de messagerie apparaît. Sur la droite, remarquez la liste des
utilisateurs connectés à ce canal. Si aucune liste n’est présente, vous êtes la seule personne connectée.
Changez de canal ou attendez que quelqu’un le rejoigne.

Répétez la même opération pour rejoindre d’autres canaux du même serveur IRC. Une nouvelle fenêtre
s’affiche pour chaque canal, ce qui vous permet de suivre plusieurs discussions à la fois.

Il existe beaucoup de références à la « netiquette » sur Internet, qui décrit les normes et les règles compor-
tementales à appliquer lorsque l’on discute avec d’autres. Vous pouvez effectuer une recherche sur les mots
« chat netiquette » (sur Google) (http://www.google.fr/search?q=chat+netiquette) pour obtenir plus de
renseignements. Notez que le terme chat signifie bavarder en anglais, du moins sur le Web.
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Chapitre 2. Multimédia

Avec MandrivaOne, vous pouvez tirez parti des options multimédias de votre ordinateur : écouter de la mu-
sique, lire des vidéos, retoucher vos photos, etc.

2.1. Jouer de la musique

2.1.1. CD audio

Lorsque vous insérez un CD audio dans votre lecteur, une boîte de dialogue s’affiche. Si vous choisissez de
jouer le CD, le lecteur KsCD démarre.

Figure 2-1. Interface principale de KsCD

Astuce :

Une fois que KsCD est lancé, cette icône apparâıt à côté de l’horloge. Faites un clic droit dessus pour accéder
aux fonctionnalités de KsCD.

À gauche se trouvent les commandes classiques d’un lecteur CD : Lecture/Pause, Arrêter, Éjection, etc. Celles
qui se trouvent en dessous modifient l’ordre de lecture. Le bouton CDDB donne des informations sur le disque
en cours de lecture, comme le titre de l’album, le nom de l’artiste et le titre de la chanson jouée. Un dernier
bouton permet d’afficher plus d’options de configuration avancées.

2.1.2. Fichiers son

En choisissant Multimédia→Lecteur audio depuis le menu principal, vous démarrerez Amarok. Vous
pouvez Ignorer l’assistant qui s’affiche lorsque c’est la première fois que vous lancez Amarok.
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Liste de
lecture

Navigateur Contrôle du
volume

Contrôles
de lecture

Figure 2-2. Fenêtre principale d’amaroK

La figure 2-2 montre les composantes de l’interface principale de Amarok.

Navigateur. Il affiche différents renseignements tout dépendant de la fonction sélectionnée parmi les onglets
à la gauche du navigateur.

Liste de lecture. Là où se trouvent les fichiers que vous écouterez. Faites un clic droit sur n’importe quel fichier
pour accéder à un menu vous permettant de lire ce fichier, de le supprimer de la liste de lecture, etc.

Contrôles de lecture. Les contrôles de lecture d’Amarok sont les mêmes que ceux des chaînes stéréo « stan-
dards » : Pièce précédente/suivante, Lire, Arrêter. Le bouton Lire agit aussi à titre de bouton Pause. Gardez le
bouton Arrêter enfoncé pour choisir si vous voulez arrêter la pièce immédiatement, l’arrêter après la pièce en
train de jouer, ou après que toute la liste de lecture ait été jouée.

Contrôle du volume. Faites-le glisser vers la droite pour augmenter le volume et vers la gauche pour le rédui-
re. Faites un clic droit et choisissez Égaliseur depuis le menu qui s’affiche. Cela ouvre une fenêtre d’égaliseur
dans laquelle vous pouvez augmenter les basses et les aigus, et même choisir des courbes d’égalisation de son
préétablies.

Le navigateur de Collection vous permet de visualiser et organiser votre bibliothèque musicale. Pour
l’utiliser, il vous faut créer une collection : cliquez sur le bouton Construction de la collection, cochez les
répertoires où vous voulez qu’Amarok cherche des fichiers audio, et cliquez sur OK pour commencer

le référencement.

Avertissement

Si vous avez ajouté des fichiers contenus sur des périphériques amovibles comme des clés USB ou un disque dur
externe, assurez-vous qu’ils sont disponibles au même endroit que lorsque vous avez bâti votre collection. Sinon,
Amarok sera incapable de trouver les fichiers qu’ils abritent.

Puis, ajoutez des pistes à la liste de lecture en double-cliquant sur celles que vous voulez écouter dans le
navigateur de collection. Une fois satisfait de votre liste de lecture, cliquez simplement sur le bouton

(Lecture) et profitez de votre musique.
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2.2. Graver des CD ou des DVD

Nous traitons essentiellement de l’utilisation de K3b pour effectuer des opérations classiques de gravure de
CD ; la gravure de DVD est très similaire.

Matériel sous copyright. Notez que la copie de CD ou de DVD audio, vidéo ou de données est souvent interdite par des
lois sur le copyright. Nous partons du principe que si vous souhaitez dupliquer des données sous copyright, c’est parce
que vous en avez le droit.

En choisissant Multimédia→Gravure de CD et DVD depuis le menu principal, vous démarrerez K3b. La figure
2-3 montre l’interface de K3b dans laquelle est ouvert un nouveau projet de données.

Barre d’outils

Gestionnaire
de fichiers

Gestionnaire
de projet

Figure 2-3. L’interface de K3b

Barre d’outils. Où vous trouverez les boutons pour effectuer les tâches courantes : ouvrir et enregistrer des
projets, effacer des supports ré-inscriptibles, copier des CD, etc.

Gestionnaire de fichiers. Pour sélectionner les fichiers à graver sur le CD. Utilisez l’arborescence de gauche
pour naviguer dans l’arborescence locale, et glissez-déposez (drag-and-drop) les fichiers à graver dans le ges-
tionnaire de projet.

Gestionnaire de projet. Endroit où les fichiers à graver sont gérés. Les fichiers peuvent y être effacés et leur
emplacement — soit le répertoire dans lequel ils résident — sur le CD peut être modifié.

2.2.1. Graver un ensemble de fichiers ou de répertoires

Choisissez Fichier→Nouveau projet→Nouveau projet de CD de données depuis le menu de K3b . Ensuite, glissez
les fichiers ou répertoires à inclure sur le CD dans le gestionnaire de projets (voir figure 2-4).
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Figure 2-4. Choisir les fichiers et les répertoires à inclure sur le CD

Note : Ajouter des répertoires contenant beaucoup de fichiers peut prendre du temps. Veuillez patienter et attendre que
le message Ajout des fichiers au Projet NOM_DU_PROJET disparaisse.

L’espace qu’occupent les fichiers et répertoires est représenté par une barre de couleur située au bas du ges-
tionnaire de projets. Vous verrez aussi l’espace en terme de Mo ainsi que la capacité disponible en Mo. Voici
ce que signifient les couleurs :

Vert

La taille de l’ensemble des fichiers est inférieure à la capacité maximale du support, soit 700 Mo par
défaut. Il n’y a pas de problème relatif à la capacité.

Jaune

La taille de l’ensemble des fichiers équivaut presque à celle du support. S’il ne s’agit que de quelques Mo
sous la capacité maximale, il n’y aura pas de problèmes. Toutefois, si la taille de l’ensemble des fichiers
excède légèrement celle du support, il est possible que la gravure s’effectue avec succès, mais rien n’est
certain.

Rouge

La taille de l’ensemble des fichiers excède largement celle du support. Le CD ne sera pas gravé correcte-
ment.

En faisant un clic droit sur n’importe quel fichier ou répertoire situés dans le gestionnaire de projets, un menu
contextuel contenant quelques options s’affiche. Ces options permettent d’effacer ou de renommer les fichiers,
de créer de nouveaux répertoires (vides), etc. Les fichiers et les répertoires peuvent être déplacés sur le CD en
faisant un glisser-déposer.

Astuce : Si vous renommez l’élément racine de l’arborescence de gauche du gestionnaire de projets, cela change le nom
de volume du CD (K3b data project par défaut pour les CD de données).
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Insérez un support inscriptible dans le graveur de CD et cliquez sur Graver, ou choisissez l’entrée de menu
Projet→Graver. Choisissez alors les paramètres de gravure (voir figure 2-5) et cliquez sur Graver pour com-
mencer la gravure.

Figure 2-5. Régler les paramètres de gravure

2.2.2. Graver des CD audio (CDDA)

Par CD audio, nous entendons des CD que vous pouvez écouter dans le lecteur de votre auto ou à la maison
sur votre chaîne audio, et non des CD de données contenant des OGG, MP3 ou tout autre format de fichier
audio compressé.

K3b prend en charge l’enregistrement de CD audio depuis des pistes digitalisées en format WAV (*.wav), Ogg
Vorbis (*.ogg) et MP3 (*.mp3). Vous pouvez mélanger les formats audio digitaux. K3b décompressera à la
volée ceux qui sont compressés. K3b peut aussi extraire et compresser des pistes audio depuis des CD audio.

Choisissez Fichier→Nouveau projet→Nouveau projet de CD audio depuis le menu de K3b. Sélectionnez le type
de Filtre du gestionnaire de fichiers pour ne garder que les fichiers sonores, naviguez jusqu’à l’emplacement
des fichiers audio, puis glissez-déposez les pistes audio dans le gestionnaire de projets (voir figure 2-6).
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Figure 2-6. Choix des pistes audio à inclure sur le CD

Déplacez les fichiers dans l’ordre qui vous plaît avec la souris. Une fois vos pistes compilées dans l’ordre
désiré, vous pouvez les graver sur un CD.

2.3. Regarder des films

Choisissez Multimédia→Lecteur multimédia dans le menu principal pour lancer KMplayer.
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Contrôles
de lecture

Statut

Barre d’outils

Zone
d’affichage

Figure 2-7. L’interface de KMplayer

L’interface de KMplayer est très simple (figure 2-7) et se compose des éléments suivants :

Barre d’outils. Cette barre comporte les boutons permettant d’ouvrir un média, de contrôler la lecture (bou-
tons de lecture, pause, stop), de passer en plein écran, etc.

Contrôles de lecture. L’ensemble des commandes habituelles d’un magnétoscope : Éjecter, Précédent, Lire
(raccourci clavier : R), Suivant, Stop (raccourci clavier : S) et Pause (raccourci clavier : P).

Zone d’affichage. Où le film s’affiche. Pressez la touche F pour passer en mode plein écran, ou en sortir.

Statut. Située en bas de la fenêtre de KMplayer, cette zone affiche des informations sur l’état de la lecture et le
film en cours.

Comment lire un fichier vidéo

1. Choisissez Source→Ouvrir pour afficher un dialogue de choix de fichiers.

2. Ouvrez le dossier contenant la vidéo à visualiser et sélectionnez-la.

3. Cliquez sur Ouvrir. La vidéo démarre immédiatement.

Comment lire un DVD

1. Insérez le DVD dans le lecteur.

2. Choisissez Source→DVD→Ouvrir un DVD.

3. La lecture commence immédiatement.

Note : Les DVD comportent généralement un menu où il est possible de choisir la langue et les sous-titres du film :
vous pouvez naviguer dans ce menu avec la souris.
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2.4. Studio de photos numériques

Choisissez MultimédiaGraphisme→Gestionnaire de photos dans le menu principal pour lancer digiKam.
Lors de la première utilisation, vous devrez assigner un répertoire par défaut pour l’enregistrement
des images. Vous pouvez accepter le répertoire par défaut /home/votre_identifiant/Images.

2.4.1. Créer un album photo

Choisissez Album→Créer un album dans le menu et remplissez les propriétés de l’album (voir figure
2-8), puis acceptez les paramètres pour créer l’album.

Figure 2-8. Propriétés du nouvel album

Choisissez Album+Importer→Ajouter des images dans le menu puis, sélectionnez les images pour
enrichir votre album photo et cliquez sur Ajouter.

Astuce : Vous pouvez ajouter toutes les images d’un répertoire donné en choisissant l’option Album+Importer→Importer
des dossiers dans le menu et sélectionnez des répertoires plutôt que des images.

2.4.2. Retouche d’images

Faites un double-clic sur une image pour ouvrir la fenêtre d’édition. Notez que toutes les opérations de re-
touche affectent la qualité du fichier de la photo sur le disque. Gardez aussi à l’esprit que le rendu des couleurs
à l’écran est différent de celui obtenu lors de l’impression de vos photos. De sorte que si vous envisagez à la
fois l’impression et la publication en ligne de vos photos, mieux vaut faire deux copies de l’image avant toute
chose, et de les traiter séparément.

Astuce : Pressez Ctrl-Z pour annuler la dernière transformation. Cependant, une fois que l’image a été enregistrée, les
changements ne peuvent plus être annulés.
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Rotation

Choisissez un des éléments (90o, 180o ou 270o) du menu Transformer+Pivoter.

Note : Si vous pivotez des images à la main , il est préférable de corriger l’information d’orientation EXIF pour que
cette information reflète l’image correctement. Dans la fenêtre de navigation de l’album, choisissez l’image et sélectionnez
l’élément approprié dans le menu Image→Corriger l’étiquette d’orientation Exif.

Luminosité, contraste et gamma

Choisissez le menu Corriger+Couleurs→Luminosité/Contraste/Gamma et utilisez les curseurs pour ajuster ces
paramètres de l’image, en utilisant l’aperçu pour vous guider.

Netteté

Choisissez Corriger→Rendre l’image nette, déplacez le pointeur sur la partie de l’image à utiliser comme guide,
et utilisez le curseur pour modifier la netteté de l’image.
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Correction des yeux rouges

Avant Après

Sélectionnez à l’aide de la souris la pupille de l’œil à corriger, choisissez Corriger→Corriger les yeux rouges dans
le menu, puis choisissez une option de correction suivant les indications données. Répétez l’opération pour
chaque œil.

Résolution et redimensionnement d’image

Les images de plusieurs mégapixels sont parfaites pour l’impression sur papier photo, mais elles ne
conviennent pas pour l’envoi par courrier électronique ou la publication sur le Web. Choisissez Transformer→
Redimmensionner depuis le menu, puis sélectionnez la taille voulue, soit en pixels ou en pourcentage. Choisis-
sez aussi de garder ou non l’aspect ratio : c’est l’option recommandée..

Vous pouvez aussi redimensionner une image à une taille voulue en gardant l’aspect ratio. Choisissez
Transformer→Recadrer selon un ratio depuis le menu, glissez le carré pour cadrer la partie de l’image qui vous
intéresse, et sélectionnez l’aspect ratio, l’orientation, la largeur et la hauteur : ces éléments se suivent selon
l’aspect ration choisi.
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Astuce : Pour une publication au format électronique, le ratio d’affichage est généralement de 4:3, alors que pour
l’impression, on utilise plutôt du 3:2.

Une taille de 640x480 est généralement suffisante pour envoyer une photo par courrier électronique, et une taille de
800x600 suffit à de la publication Web.
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Chapitre 3. Effectuer des tâches bureautiques

MandrivaOne vous permet d’utiliser des applications bureautiques comme la suite OpenOffice.org. Nous vous
expliquons comment créer des documents avec OpenOffice.org Writer, des feuilles de calcul avec OpenOffice.org
Calc et des présentations avec OpenOffice.org Impress. Les applications OpenOffice.org sont compatibles avec
Microsoft® Office, ce qui signifie que vous pouvez échanger des documents entre ces deux suites.

Astuce :

OpenOffice.org Writer est capable d’exporter vos documents au format PDF (en choisissant le menu Fichier→
Exporter au format PDF). Cela permet de communiquer vos documents dans le célèbre format Adobe® Rea-
der®.

3.1. Écrire des documents

Choisissez Bureautique→Traitement de texte à partir du menu principal pour lancer OpenOffice.org Writer.

3.1.1. Interface de traitement de texte

Barre de mise en forme

Règles

Point
d’insertion

Style
de page

Aire de
travail

Figure 3-1. La fenêtre principale d’OpenOffice.org Writer

Barre de mise en forme

Voici la barre de mise en forme standard pour toutes les applications OpenOffice.org. Elle est utilisée pour
changer les types de police, les couleurs, l’alignement, etc.

Règles

Elles définissent la position horizontale du texte et des éléments de mise en page. Elles sont très utiles
lorsque vous voulez régler des tabulations ou des indentations de paragraphe.

Aire de travail

Espace où vous entrez le contenu de votre document : mots, nombres, images, tableaux, hyperliens, etc.
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Point d’insertion

Tous les caractères que vous tapez sont placés à gauche de ce point. Le point d’insertion est également
appelé curseur.

Style de page

La taille de la page, les marges, l’orientation du texte, etc., définissent le style d’un document. Le style de
page peut être modifié par l’entremise du menu Format→Page. Vous pouvez utiliser les styles prédéfinis
ou en créer vous-même.

3.1.2. Styles

De manière générale, les utilisateurs de traitement de texte perdent beaucoup de temps à formater leur do-
cument (changer l’alignement des paragraphes, le type de police, la taille du document, etc.) au lieu de se
concentrer sur leur structure et leur contenu.

L’utilisation de styles permet une approche mettant l’accent sur la structure, tout en normalisant le
formatage et la mise en page d’un document. Elle facilite aussi la génération et l’entretien d’une table
des matières (TDM), d’un index, d’une bibliographie, etc. Sous OpenOffice.org Writer, les styles sont

gérés par l’entremise du Styliste. Cliquez sur son icône dans la barre de mise en forme pour l’ouvrir ou le
fermer.

Lorsque vous voulez utiliser... Appliquez le Style...

Titre de chapitre Titre 1

Titre de section Titre 2

Titre de sous-section Titre 3

Titre de sous-sous-section Titre 4

Paragraphe Corps de texte, Alinéa

Élément de liste Indentation de liste

Tableau 3-1. Styles de texte suggérés

Utilisez les styles décrits dans tableau 3-1, en tant que guide. Choisissez la région du document à laquelle vous
voulez appliquer un style précis et, dans la fenêtre du Styliste, double-cliquez sur le style de votre choix.

3.1.3. Listes

Utilisez des listes pour énumérer les propriétés d’un objet (liste « non ordonnée » ou « à puce »), ou pour
décrire les étapes nécessaires pour accomplir une tâche donnée (liste « ordonnée » ou « numérotée »).

Cliquez sur ce bouton pour transformer le texte sélectionné en liste non ordonnée. Pour modifier le
type de puce : sélectionnez les éléments de la liste et cliquez sur le menu Format→Numérotation/puces.

Cliquez sur ce bouton pour transformer le texte sélectionné en liste ordonnée. Les mêmes règles que
pour les listes non ordonnées s’appliquent en ce qui concerne le format de numérotation.

3.1.4. En-têtes et pieds de page

Par défaut, ils sont communs à toutes les pages d’un document. Utilisez-les pour décrire certains aspects du
contenu d’un document, par exemple, le numéro de page, le nombre total de pages, le titre d’un chapitre ou
d’une section, le titre d’un document, etc.

Choisissez Insertion+En-tête→Standard depuis le menu pour ajouter une en-tête ou Insertion+Pied de page→
Standard pour un pied de page. Tapez un texte pertinent pour l’un et l’autre de ces composants ou utilisez une
ou plusieurs entrées du menu Insertion→Champ pour composer des en-têtes et des pieds de page.
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3.2. Calculs et simulations

Sélectionnez Bureautique→Tableurs depuis le menu principal pour lancer OpenOffice.org Calc.

3.2.1. Interface de tableur

Barre de
mise en forme

Aire de
travail

Sélectionner
tout

Barre de
formule

Onglets des
feuilles de calcul

Figure 3-2. La fenêtre principale d’OpenOffice.org Calc

Barre de mise en forme

Il s’agit de la barre de mise en forme commune à toutes les applications OpenOffice.org pour modifier la
police, la couleur, l’alignement, etc., des données de l’application.

Barre de formule

Utilisez cette barre pour écrire, modifier ou supprimer une formule dans une cellule.

Aire de travail

La feuille de calcul proprement dite sur laquelle entrer et afficher les données : nombres, dates, formules,
images, etc.

Sélectionner tout

Cliquez sur cette zone située dans le coin supérieur gauche de la zone de travail pour sélectionner toutes
les cellules d’un seul coup. C’est utile si vous désirez appliquer des changements « globaux » sur toute la
feuille. Par exemple, en changeant la taille des polices à 10pts (points).

Boutons et onglets de changement de feuille

Un document de feuilles de calcul comporte généralement plusieurs feuilles. Utilisez ces boutons pour
naviguer facilement d’une feuille à l’autre. De gauche à droite nous avons : Aller à la première feuille, Aller
à la feuille précédente, Aller à la feuille suivante et Aller à la dernière feuille. Vous pouvez aussi utiliser les
onglets.
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3.2.2. Saisie de données

Pour saisir des données dans une cellule, allez dans la cellule, tapez vos données et appuyez sur la touche
Entrée.

La fonctionnalité de complètement automatique facilite l’entrée de données. Le programme essaye de « de-
viner » les données à insérer dans la cellule suivante en fonction de la cellule courante. Cela fonctionne pour
tout type de données correspondant à une série d’entiers.

Pour utiliser le complétement automatique, placez votre souris au-dessus de la « poignée » de la cellule (le
petit carré situé sur le coin inférieur droit du bord de la cellule), cliquez dessus et glissez la cellule. La valeur
des cellules est ensuite affichée dans une bulle. Une fois que vous avez obtenu la valeur désirée, relâchez le
bouton de la souris pour que les cellules soient remplies.

Les cellules peuvent aussi être triées en fonction de divers critères. Sélectionnez la zone de cellules que vous
souhaitez trier puis ouvrez le dialogue de tri en choisissant le menu Données→Trier. Spécifiez le critère, l’ordre
et les options additionnelles puis cliquez sur OK.

Astuce : Assurez-vous de sélectionner aussi les cellules qui servent d’en-tête aux données (dans notre exemple la
colonne B qui contient le nom des mois) de façon à ce que celles-ci suivent aussi le tri des données.

3.2.3. Ajout de formules

Les formules sont utilisées pour « automatiser » la feuille de calcul ce qui vous permet, par exemple, de lancer
des simulations. Dans les cellules, les formules sont définies en rentrant le signe =. Tout le reste est traité
comme des données « statiques ».

Les opérations sont décrites en utilisant la notation algébrique conventionnelle. Par exemple =3*A25+4*(A20+C34/B34)
divise la valeur de la cellule C34 par celle de la cellule B34, ajoute la valeur de la cellule A20 au résultat, mul-
tiplie ce dernier par 4 puis ajoute 3 fois la valeur de la cellule A25. Ainsi, des expressions assez complexes
peuvent être simplifiées en utilisant des expressions plus simples à la base.

OpenOffice.org Calc propose un grand nombre de fonctions prédéfinies utilisables dans les formules. Explorez
toutes ces fonctions en choisissant le menu Insertion→Fonction.

Astuce :

Vous pouvez aussi cliquer sur le bouton d’assistant pour obtenir de l’aide afin d’entrer une formule.

3.2.4. Diagrammes : présentation graphique des données

Lorsqu’une feuille de calcul contient beaucoup d’informations, il devient difficile de cerner les relations entre
les différents types de données : trop de chiffres et pas assez de sens. La meilleure façon de représenter ces
données est d’utiliser des graphiques.

Comme pour toutes les fonctions d’analyse de données, il faut préalablement sélectionner les données que
vous souhaitez afficher dans le diagramme. Sélectionnez donc une zone de cellules, puis choisissez le menu
Insertion→Diagramme pour afficher l’assistant de création de diagrammes.

Choisissez le type, la variante, le titre, les titres d’axe, etc. de votre graphique et cliquez sur Créer pour créer et
insérer le graphique dans la feuille de calcul.

Astuce : Les diagrammes sont actifs dans la feuille de style, et s’adaptent automatiquement lorsque vous modifiez les
valeurs des cellules affichées dans le diagramme.

Astuce : Un double-clic, puis un clic droit sur un diagramme fait apparâıtre un menu avec des options permettant de
changer de nombreux paramètres de ce diagramme.
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3.3. Présenter vos idées

Choisissez Bureautique→Présentations depuis le menu principal pour lancer OpenOffice.org Impress. Un as-
sistant vous propose de l’aide pour créer une présentation, mais nous ne le détaillerons pas dans cette section.
Créez simplement une présentation vierge en cliquant sur Créer.

3.3.1. Interface du logiciel de présentations

Barre d’outils

Aire de
travail

Mise en forme des transparents

Modèles

Aperçu des
transparents

Figure 3-3. La fenêtre principale d’OpenOffice.org Impress

Barre de mise en forme

Elle comprend des options qui permettent de définir les ombres des diapositives, la couleur d’arrière-
plan, l’épaisseur des lignes, etc.

Aire de travail

Où vous composez les diapositives de votre présentation.

Barre d’outils

Elle contient les outils principaux permettant de concevoir les diapositives, tels que l’outil texte, les for-
mes, les courbes, les lignes et les flèches ; les outils de rotation d’objet, d’effets spéciaux ; etc.

Astuce : Certains de ces boutons ont un petit triangle sur le côté. En appuyant sur ceux-ci, vous ouvrirez un menu
contenant des options spécifiques à cet outil. Par exemple, insérer un rectangle (plein ou vide), avec des rebords
courbés ou droits, etc.

Volet Tâches

Ici, vous trouvez plusieurs modèles de présentations disponibles. Sélectionnez celui que vous voulez pour
transformer la diapositive courante.
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Volet Diapos

Affiche la liste des diapositives composant la présentation. Les diapositives affichées sont miniaturisées
de manière à voir rapidement ce à quoi elles ressemblent. Pour modifier une diapositive, cherchez-la dans
la liste et cliquez dessus.

3.3.2. Ajouter des diapositives à votre présentation

Cliquez sur ce bouton dans la barre d’outils ou choisissez Insertion→Diapo dans le menu pour ajouter
une diapositive, avec le modèle de document actuel.

Astuce : Choisissez Insertion→Dupliquer la page si vous préférez vous appuyer sur la diapositive courante.

3.3.3. Diagrammes simples

Sélectionnez Insertion→Diagramme depuis le menu pour en insérer un dans la diapo active. Une barre
de diagramme « standard » sera insérée et OpenOffice.org Impress passera en mode Diagrammes.
Cliquez à l’extérieur de la zone de diagramme pour revenir en mode édition de diapositive.

Vous pouvez ajuster la taille du diagramme en cliquant sur les bordures. Double-cliquez sur le diagramme
puis faites un clic droit sur celui-ci et choisissez Données du diagramme. Une fenêtre (figure 3-4) apparaîtra
vous permettant d’entrer les données du diagramme que vous voulez créer.

Figure 3-4. Saisir les données du diagramme

Une fois que vous aurez entré les données dans le diagramme, fermez la fenêtre de saisie de données et cliquez
sur Oui pour actualiser votre diagramme dans la diapo. Puis cliquez sur une aire vide de la diapo.

Répétez l’opération de double-clic et de clic droit afin de changer le titre, la légende, l’axe, le type (2D ou 3D),
la barre, le camembert, les points, les lignes, etc., du diagramme en choisissant les entrées appropriées depuis
le menu contextuel.

3.3.4. Arrière-plan de diapo

Utilisez le menu Format→Page et cliquez sur l’onglet Arrière-plan pour définir les couleurs, les dégradés, les
hachures, etc. de votre diapo. Chaque type d’arrière-plan possède ses propres options, explorez-les.

Note : L’utilisation de bitmap en arrière-plan augmente considérablement la taille d’un fichier. Ceci pourrait ralentir
fortement votre présentation, surtout sur les vieux systèmes.

Une fois que vous aurez choisi un arrière-plan, vous pourrez choisir de définir cet arrière-plan en standard
pour toutes les diapositives. Faites votre choix et l’arrière-plan des diapositives sera actualisé.
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3.3.5. Transitions, animations et effets

Le menu Diaporama permet d’appliquer des transitions, des animations et des effets pour dynamiser vos pré-
sentations. Essayez cependant de ne pas abuser de ces effets spéciaux. Ils pourraient distraire votre public et
détourner leur attention vers les effets en tant que tel, au détriment de votre message.

3.3.6. Lancer votre présentation

Vous pouvez lancer votre présentation par l’entremise du menu Diaporama→Diaporama, ou en appuyant sur
la touche F5. La présentation s’affichera sur tout votre écran. Pour l’arrêter, appuyez sur la touche Échap.

3.4. Pour aller plus loin

Les tutoriels disponibles sur le site Web Tutorials for OpenOffice (http://www.tutorialsforopenoffice.
org) (en anglais) sont utilise si vous voulez en apprendre plus sur l’utilisation des composants ma-
jeurs de la suite OpenOffice.org. Allez voir les tutoriels sur Writer (http://www.tutorialsforopenoffice.
org/category_index/wordprocessing.html), Calc (http://www.tutorialsforopenoffice.org/category_
index/spreadsheet.html), et Impress (http://www.tutorialsforopenoffice.org/category_index/presentation.
html).

Vous pouvez aussi utiliser l’aide en ligne qui est accessible par l’entremise du menu Aide→Aide
d’OpenOffice.org, ou en appuyant sur la touche F1. Vous devriez y trouver les réponses à vos questions.
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Chapitre 4. Partagez et installez votre système Linux

Vous pouvez facilement installer le système sur le disque dur de votre machine en suivant ces quelques étapes.

4.1. Live Install

4.1.1. Avant l’installation

Avant d’installer MandrivaOne sur votre disque dur, et si votre machine héberge déjà un système d’exploitation
(comme Windows® par exemple), il est fortement recommandé d’effectuer une défragmentation du disque afin
d’optimiser la place disponible sur le disque.

Avertissement

Effectuez systématiquement une sauvegarde de vos données sur un support amovible ou sur un autre système avant
d’installer quoi que ce soit. Les sauvegardes sont la seule assurance contre les pertes de données.

4.1.2. Copie des fichiers sur le disque

Cliquez sur cette icône du bureau pour démarrer l’assistant d’installation.

1. Où installer le système sur votre disque

Selon le contenu de votre disque, plusieurs choix sont possibles pour l’emplacement du système sur
le disque. Gardez à l’esprit que si vous réutilisez des partitions existantes d’un précédent système
d’exploitation, ou si vous les effacez, vous perdrez les données qui y sont stockées. En sélectionnant
l’option Partitionnement personnalisé, vous pourrez précisément contrôler le partitionnement en utilisant
DiskDrake (voir la section Gérer ses partitions de Guide de démarrage).

2. Copie des fichiers

Le système est alors copié sur le disque, aucune intervention n’est requise. Cela prend plusieurs minutes,
selon la vitesse de votre système.

3. Configuration du chargeur de démarrage

Cette étape installe le menu qui permet de choisir le système à démarrer à l’allumage de la machine.
Vous pouvez accepter les choix par défaut. Cliquez sur Avancé si vous avez besoin de plus d’options de
configuration.

Note : Si votre installation Windows® occupe plusieurs partitions (par exemple un portable comportant des partitions
pour le système lui-même, pour le logiciel de diagnostic, etc.) vous pouvez avoir plus d’une entrée Windows. La
première est généralement celle du système Windows®.

4. Fin

Cliquez sur le bouton Terminer puis redémarrez l’ordinateur (Menu principal+Déconnexion+Redémarrer
l’ordinateur), en enlevant le CD/DVD à la fin du cycle d’arrêt.

4.1.3. Configuration du système

Quelques paramètres doivent maintenant être configurés dès que le système a redémarré.
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4.1.3.1. Réseau

Il y a ici deux étapes principales: sélection du type de connexion et configuration des paramètres réseau,
suivant le type de connexion. Assurez-vous de posséder tous les paramètres nécessaires (par exemple : adresse
IP, serveurs DNS, passerelle IP, etc.) : votre fournisseur d’accès ou votre administrateur réseau devrait vous
les avoir fourni.

Figure 4-1. Choix du type de connexion

Connexion par modem. Sélectionnez le type Modem analogique (RTC).

Modem-cable. Certaines connexions modem-cable correspondent à une connexion Ethernet. Consultez votre fournisseur
d’accès.

Réseaux cellulaires. Pour se connecter à un réseau de téléphone cellulaire, choisissez l’entrée GPRS/Edge/3G.

1. Choix du type de connexion

Votre périphérique réseau est automatiquement détecté selon le type de réseau choisi. Sinon, vous pouvez
choisir le périphérique manuellement.

2. Paramètres réseau

Renseignez tous les paramètres réseau pour la connexion choisie.

3. Contrôle de la connexion

Après que tous les paramètres ont été remplis, il est proposé de démarrer la connexion dès le démarrage
du système ; à moins que vous n’ayez une connexion qui n’est pas censée être permanente, laissez cette
option cochée.

4. Enfin, vous pouvez tester la connexion. Si ça ne marche pas, vous pourrez revenir en arrière et faire les
ajustements nécessaires. Vous êtes désormais connecté au réseau, cliquez sur le bouton Terminer.

4.1.3.2. Mot de passe Administrateur

L’utilisateur root est l’administrateur du système, et peut faire toutes les opérations possibles sur le sys-
tème, mieux vaut donc choisir un bon mot de passe pour protéger le compte root. Ce mot de passe sera
demandé chaque fois que vous voudrez faire une tâche d’administration (comme l’installation de nouveaux
programmes) sur le système.
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Choisir un bon mot de passe : Le mot de passe devrait être un mélange de caractères alphanumériques et d’au moins
6 à 8 caractères. N’écrivez pas le mot de passe root. Attention cependant, ce mot de passe ne doit pas être trop long
ou trop compliqué, vous devez pouvoir vous en souvenir !

Le mot de passe n’est pas affiché à l’écran lorsque vous le tapez. Rentrez le deux fois pour confirmation.

4.1.3.3. Création des comptes utilisateur

Il faut aussi créer un utilisateur non privilégié (ou « normal ») pour l’utilisation courante du système.

1. Remplissez chaque champs, puis cliquez sur Accepter pour créer un premier compte. Notez que si ce mot
de passe n’est pas aussi important que celui de root, c’est tout de même ce mot de passe qui garantit
l’accès à vos données personnelles.

2. Si plusieurs personnes vont utiliser cet ordinateur, créez un compte pour chacune d’entre elles, puis cli-
quez sur Terminer.

4.1.3.4. Assistant d’enregistrement

Que vous ayez déjà un compte Mandriva ou que vous vouliez enregistrer votre nouveau produit, cet assistant
vous permettra de bénéficier de tous les avantages associés. Lisez attentivement les instructions avant de
passer d’une étape à l’autre, ou cliquez sur Ne pas configurer pour ignorer cet assistant.

Une fois cela terminé, le système est prêt à être utilisé. Entrez vos identifiants de connexion pour commencer
à utiliser le système.
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Chapitre 5. Gestion des paquetages

Pour commencer, un peu de vocabulaire.

Paquetage
Les logiciels sont constitués de plusieurs fichiers, pour faciliter leur développement et leur gestion. Au
final, une application consiste en plusieurs morceaux : les binaires, la documentation, les ressources né-
cessaires à l’application (images, icônes, traductions, sons, etc.). Un paquetage est l’ensemble des com-
posants d’une application, rassemblés dans un unique fichier, ce qui en simplifie l’installation, la mise à
jour et la suppression.

Dépendance
Les applications s’appuient sur des librairies logicielles ou des composants, créés par différents déve-
loppeurs, pour exécuter un ensemble de fonctions données, différentes de la fonction principale de
l’application, mais nécessaires pour l’accomplir. Une dépendance est un paquetage dont un autre pa-
quetage a besoin pour fonctionner correctement. L’outil de gestion des paquetages de Mandriva Linux
prend en charge automatiquement toutes les dépendances.

Mise à jour
Un logiciel est vivant : de nouvelles fonctionnalités sont ajoutées, d’autres sont améliorées et des problè-
mes (bogues) sont résolus. Une mise à jour est un paquetage qui apporte quelques-unes ou toutes ces
améliorations et réparations à une application existante. Nous vous recommandons de vérifier les mises
à jour afin de garder votre système en bon état et à l’abri de bogues et autre menaces de sécurité.

Source
Le terme source désigne à la fois un répertoire de paquetages et l’endroit à partir duquel les paquetages
sont installés. Les sources correspondant au support utilisé pendant l’installation du système sont auto-
matiquement créées et vous pouvez ajouter vos propres sources pour les mises à jour et les paquetages
que vous trouvez sur Internet par exemple.

Média
L’endroit physique où sont stockés les paquetages logiciels, que ce soit sur CD, DVD, ou un serveur FTP.

Répertoire
Site centralisé regroupant des médias (et donc des paquetages).

Mandriva Linux utilise le système de paquetage RPM. Mandriva Linux propose des outils pratiques qui sim-
plifient la gestion des logiciels. L’ensemble des outils urpmi s’exécutent par la ligne de commande.. Dans ce
chapitre, nous nous concentrerons sur Rpmdrake : l’outil graphique d’installation de logiciels Mandriva Linux
et sur le Gestionnaire de média. figure 5-1 montre la section Gestion de logiciels de Centre de contrôle Mandriva
Linux.
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Figure 5-1. Gestion d’applications dans le Centre de contrôle Mandriva Linux

Rpmdrake peut être utilisé dans un des trois modes : installation

, suppression

et mise à jour

, expliqués dans Installation et suppression de logiciels, page 40. La gestion des média est traitée dans Le
gestionnaire de médias, page 43.

5.1. Installation et suppression de logiciels

Ajouter des médias supplémentaires au premier démarrage : Lorsque vous démarrez cet outils pour la première fois, il
est proposé d’ajouter de nouveaux médias d’installation officiels. Cela vous donnera accès, par Internet, à beaucoup plus
de logiciels que ceux qui tiennent sur votre CD ou même DVD. Ajoutez les si vous avez une connexion Internet rapide.

Au lancement de cet outil, il faut patienter quelques secondes pendant que Rpmdrake charge la base de données
des paquetages. Puis, l’interface principale de Rpmdrake apparaît.
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Arbre des 
catégories

Liste des paquetages

Description
 du paquetage

Groupe de
paquetages

Recherche de 
paquetage

Figure 5-2. Interface de Rpmdrake

Groupe de paquetages. Utilisez cette liste déroulante pour sélectionner le type de paquetage à afficher : tous
les paquetages (installés ou non), les paquetages installés seulement (à désinstaller), les paquetages non ins-
tallés seulement (à installer). Quelques options sont aussi disponibles pour les paquetages mis à jour (toutes
les mises à jour, les mises à jour de sécurité, les correction de bogues, les mises à jour normales). Chaque fois
qu’un groupe de paquetages est sélectionné, l’arbre des catégories est reconstruit pour afficher uniquement
les paquetages correspondants.

Recherche de paquetage. Si vous n’êtes pas sûr du nom d’un paquetage, utilisez cet outil pour le chercher.
Entrez la chaîne de caractère à rechercher, sélectionnez le critère en utilisant la liste déroulante et cliquez sur
Rechercher. Vous pouvez rechercher des paquetages par nom (dans noms), par description (dans descriptions)
et par paquetages, en fournissant le nom d’un fichier (dans noms de fichiers).

Note : Si vos répertoires de média logiciels sont configurés pour utiliser les listes résumées de paquetages (les fichiers
de résumé synthesis, et non les formats complets hdlist), vous ne pourrez pas effectuer une recherche en entrant un
nom de fichier. Vous pourrez uniquement rechercher les paquetages par nom et par description.

Arbre des catégories. Pour faciliter leur gestion, les paquetages sont rangés en catégories (Réseau, Bureau-
tique, Jeux, Développement, Graphisme, etc. ).Ouvrez une catégorie pour afficher les paquetages correspon-
dants aux critères de sélection utilisés dans Groupe de paquetages et dans Recherche de paquetage.

Liste des paquetages. Les paquetages correspondants aux critères (de Groupe,de Catégorie et de Recherche)
s’affichent ici. Vous pouvez sélectionner les paquetages à installer, à supprimer et à mettre à jour.

Description du paquetage. affiche des informations détaillées sur le paquetage actuellement sélectionné dans
la liste des paquetages.

Actions sur les paquetages

1. Réduisez la liste de paquetages affichés

Utilisez la liste déroulante de groupe de paquetages, l’arbre des catégories et éventuellement l’outil de
recherche pour naviguer parmi les paquetages à installer, supprimer, ou mettre à jour.

2. Sélectionnez les paquetages

Dans la liste de paquetages, sélectionnez ceux qui doivent être installés, enlevés, ou mis à jour. Si la case
près du nom du paquetage est vide, cela veut dire qu’il peut être installé ou mis à jour. Une fois sélectionné,
il sera précédé de l’icône

. Si l’icône
apparaît à la place de cette case, cela signifie que le paquetage est déjà installé, sélectionnez-le pour
le supprimer, il sera alors marqué avec l’icône

.

3. Appliquez les changements
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Une fois que vous êtes satisfait de vos choix, cliquez sur Appliquer pour effectuer l’installation, la sup-
pression et la mise à jour des paquetages. Une nouvelle fenêtre apparaîtra, montrant la progression du
processus d’installation. Si vous préférez quitter en n’installant aucun logiciel, utilisez le bouton Quitter.

Gestion des dépendances

Il se peut que vous choisissiez un paquetage qui a lui même besoin d’autres paquetages (bibliothèques ou
autres nécessaires à son bon fonctionnement). Dans ce cas, Rpmdrake affichera un avertissement présentant
la liste de ces paquetages nécessaires (dépendances). Vous pouvez soit accepter, soit Annuler l’installation ou
obtenir Plus d’infos sur ce paquetage (figure 5-3).

Figure 5-3. Alerte dépendances

Dépendances alternatives. Il peut aussi arriver que vous installiez un paquetage qui nécessite des dépendan-
ces (librairies supplémentaires ou d’autres outils) et que plusieurs paquetages différents soient en mesure de
fournir une même dépendance. La liste de tous les choix susceptibles de convenir (figure 5-4) vous sera alors
proposée. Lisez les descriptions des options en cliquant sur le bouton Info... et choisissez celui qui vous semble
convenir le mieux.

Figure 5-4. Autres choix de paquetages

Note : L’espace disque requis pour l’installation des paquetages sélectionnés peut être supérieur à la taille du paquetage
en lui-même. Ceci est dû à la nécessité d’installer ses dépendances.

5.2. Mise à jour de paquetages

Cette interfac permet de rapidement vérifier l’existence de mises à jour et de les installer en un clic.

Ajout des médias de mise à jour. La première fois que vous lancez cet outil, il est demandé d’installer les
médias de mise à jour. Suivez les instructions pour ce faire.
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Figure 5-5. Mise à jour des paquetages

1. Par défaut, toutes les mises à jour (sauf pour le noyau) sont sélectionnés pour être installées, vérifiez la
liste.

2. Cliquez sur Update pour lancer le processus de mise à jour qui sconsiste à télécharger les paquetages
sélectionés, puis les installer.

Mises à jour du noyau (kernel) : Les mises à jour du noyau Linux ne sont pas sélectionnées par défaut, il faudra donc
sélectionnerle paquetage kernel-*-latest manuellement.

Notification des mises à jour : L’applet Mandriva Update qui se trouve sur le panneau vous avertit de la disponibilité
de nouvelles mises à jour lorsque les médias correspondants sont installés. Elle affiche une icône rouge

lorsque des mises à jours sont disponibles, et une icône verte

lorsque votre système est à jour.

5.3. Le gestionnaire de médias

Utilisez cet outil pour configurer les répertoires de média logiciels. Dans la figure 5-6 certains mé-
dias sont déjà disponibles : « Main », « Contrib », etc. Vous pouvez aussi ajouter d’autres médias
logiciel : un CD que vous avez récupéré dans un magazine contenant des RPMs, un média réseau

sur Internet, etc.
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Figure 5-6. Le gestionnaire de médias logiciel

Cochez les cases sur la colonne de gauche pour marquer les répertoires

Activé?

Décochez cette boîte pour désactiver temporairement le média correspondant. Les paquetages que ce
média contient seront indisponibles jusqu’à ce que vous réactiviez ce média.

M.à.J.?

Cette boîte doit être cochée à coté du média de mise à jour, c’est-à-dire celui qui contient les paquetages
de mise à jour. Ainsi seuls les médias de mise à jour seront pris en compte lorsque vous chercherez des
mises à jour.

Boutons d’actions à droite

Supprimer

Supprime un média que vous ne souhaitez plus utiliser. Il suffit de sélectionner le média à enlever de la
liste, puis de cliquer sur ce bouton.

Éditer

Modifie les paramètres du média sélectionné, comme l’URL ou le chemin relatif vers le fichier synthesis/
hdlist (si vous ne savez pas de quoi nous parlons ici, mieux vaut ne toucher à rien et cliquer sur Annuler
au lieu de Sauvegarder).

Au cas où il vous faudrait passer par l’intermédiaire d’un mandataire (proxy) pour accéder à ce média
spécifique, cliquez sur le bouton Mandataire..

Des mises à jour de médias plus rapides. La chaîne contenant le chemin relatif permet de changer le
format de fichier hdlist vers le format synthesis, qui est beaucoup plus compact, mais comporte moins
d’information concernant les paquetages. Les fichiers « synthétiques » ne contiennent que le nom des
paquetages, leur dépendances et un court résumé. Vous ne pourrez pas rechercher des fichiers à l’intérieur
des paquetages par exemple, ou sa description complète.
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Pour passer à la forme synthétique des fichiers hdlist, il suffit de préfixer le nom du fichier par
synthesis., par exemple : media_info/hdlist_main.cz deviendra media_info/synthesis.hdlist_
main.cz.

Ajouter...

Ajoute sur votre système toutes les sources officielles accessibles au public à partir de répertoires situés
sur Internet. C’est pratique, si par exemple, vous avez une connexion Internet haut débit, ou si vous
n’avez que le premier CD d’installation sous la main. Choisissez un miroir proche de votre emplacement
géographique.

Une fois que vous avez choisi votre miroir et cliqué sur OK, les informations relatives aux paquetages de
la source choisie sont téléchargées et tous les paquetages de cette source seront disponibles

Ajouter la source personnalisée

Ce bouton permet d’accéder à un nouveau dialogue, dans lequel vous entrez tous les paramètres requis
pour ajouter un nouveau média logiciel. Gardez à l’esprit que ces paramètres ainsi que les options dispo-
nibles dépendent du type de média défini.

Figure 5-7. Ajout d’une source personnalisée

Mettre à jour

Une liste de tous les médias activés apparaît ; sélectionnez ceux que vous voulez mettre à jour et cliquez
sur Mettre à jour. Ceci est notamment utile pour les médias distants auxquels sont ajoutés de nouveaux
paquetages.

Gérer les clés

Il est important que les nouveaux paquetages logiciel que vous installez soient authentifiés. Pour cela,
chaque paquetage peut être signé électroniquement avec une « clé », et vous pouvez autoriser/interdire
des clés pour chaque média. Sur figure 5-8, vous pouvez voir que la clé de Mandriva Linux est autorisée
pour le média « Main ». Cliquez sur Ajouter pour autoriser une autre clé pour ce média (attention, procé-
dez avec précaution, comme pour toutes les questions relatives à la sécurité de votre système), et sur
Supprimer pour enlever la clé du média sélectionné.
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Figure 5-8. Gestion des clés d’authentification des sources

Mandataire...

(Proxy) : Si votre ordinateur est placé derrière un pare-feu, mais que vous souhaitez néanmoins utiliser les
possibilités qu’offre Rpmdrake d’accéder à des médias sur Internet (pour les mises à jour notamment), il
peut être nécessaire de passer par un serveur mandataire (ne serait-ce que pour l’accès à certains serveurs
de paquetage). Remplissez le champ Nom du serveur mandataire et éventuellement les nom d’utilisateur /
mot de passe pour se connecter au mandataire. Confirmez alors votre configuration en cliquant sur OK.

Figure 5-9. Configuration d’un mandataire pour un média distant

Parallèle...

Si vous utilisez un grand réseau d’ordinateurs, vous pouvez souhaiter installer un paquetage logiciel
sur tous les ordinateurs, en parallèle ; ce bouton ouvrira une fenêtre vous permettant de configurer le
mode « Parallèle ». Comme cela est assez compliqué, et utile pour une frange limitée d’utilisateurs, nous
n’entrerons pas plus dans les détails.

Option générales...

Ce bouton vous permet de configurer l’utilitaire de téléchargement des nouveaux paquetages, et de dé-
sactiver la vérification des paquetages par rapport aux clés de chiffrement. Ces choix sont utilisés pour
toutes les sources.

Flèches haut et bas

Ces boutons permettent de changer l’ordre dans lequel les sources sont prises en compte lorsque le systè-
me essaye d’installer un paquetage. Par défaut, la version la plus récente d’un paquetage sera toujours
installée, mais si la même version est disponible sur deux média différents, c’est celle du premier média
dans la liste qui sera installée

Astuce : Par conséquence, il préférable de mettre le média le plus rapide en premier...
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6.1. Configurer votre matériel

6.1.1. Détection et configuration du matériel

Le projet HardDrake a été développé pour simplifier la configuration du matériel sous GNU/Linux
en proposant une interface simple à utiliser.

6.1.1.1. Introduction à HardDrake

HardDrake est à la fois un service de détection matérielle, qui s’exécute au démarrage, et un outil graphique,
qui rassemble de nombreux outils inclus dans une distribution GNU/Linux. Son but est d’automatiser et de
simplifier l’installation de nouveaux matériels. HardDrake est capable de détecter la plupart des matériels exis-
tants.

HardDrake peut être utilisé pour afficher des informations et pour lancer des outils de configuration. Avec une
interface simple, vous serez capable de parcourir tous les périphériques qui composent votre système.

6.1.1.2. Utilisation

Pour lancer HardDrake, vous pouvez utiliser :

• le Centre de contrôle Mandriva Linux : cliquez sur l’icône correspondant à la catégorie Matériel puis cliquez
sur l’icône Matériel .

• un terminal : tapez harddrake2 en tant que root. Vous pouvez également entrer des paramètres ; tapez
harddrake2 -h pour en obtenir la liste.

• le bureau : allez dans le menu principal. HardDrake se trouve dans Système+Configuration+Matériel→
HardDrake.

Une fois le matériel détecté, la fenêtre principale de HardDrake apparaît (figure 6-1).

A gauche, vous pouvez voir l’arbre des périphériques montrant toutes les catégories.

Figure 6-1. Périphérique Sélectionné
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Si vous sélectionnez un périphérique, vous obtiendrez des informations utiles le concernant dans le cadre de
droite. Vous pouvez accéder à la page d’aide en choisissant Aide→Description des champs.

Selon le périphérique sélectionné, d’autres boutons peuvent apparaître :

• Spécifier les options du pilote courant. Ouvre une boîte de dialogue contenant tous les paramètres du
gestionnaire de périphériques. À réserver aux experts !

• Lancer l’outil de configuration. Lance l’outil de configuration Mandriva Linux associé à ce périphérique. Ce
sont les outils disponibles dans le Centre de contrôle Mandriva Linux.

Matériel Inconnu. Il existe une catégorie spéciale appelée Inconnus/Autres, qui contient tous les matériels
actuellement inconnus ou qui ne rentrent dans aucune des autres catégories (capteurs thermiques, générateurs
de nombre aléatoire, ...).

6.1.2. Problèmes et solutions

Si vous pensez avoir trouvé un bogue en rapport avec HardDrake, déclarez-le en utilisant l’outil de signalement
de bogue Mandriva Linux

Cartes son. Les périphériques ISA PnP ne sont pas testés par HardDrake. Si vous possédez une carte son ISA
PnP, lancez sndconfig ou alsaconf en ligne de commande afin de la configurer. Vous devrez sans doute
installer les paquetages suivants : sndconfig ou alsa-utils.

6.2. Contrôler la configuration graphique

Cet ensemble d’outils vous permet de configurer l’affichage graphique. Vous serez en mesure de changer le
choix de carte graphique, de résolution et de moniteur (ou d’écran). Cet outil peut être utile si vous modifiez
un composant graphique après l’installation initiale de Mandriva Linux.

Si vous ne voyez pas l’écran de connexion graphique au démarrage : Si le serveur graphique ne peut démarrer à
cause d’une erreur de configuration, un message vous proposera de reconfigurer le serveur graphique. Vous obtiendrez
alors le même outil que celui décrit dans Contrôler tous les paramètres vidéo, page 52, mais en mode texte.

L’outil de configuration graphique est accessible par l’intermédiaire de différentes icônes dans la section Ma-
tériel du Centre de contrôle Mandriva Linux :

6.2.1. Choisir un nouveau moniteur

Cet outil permet de changer le type de moniteur que vous utilisez. Cliquez sur ce bouton et une
fenêtre apparaîtra dans laquelle seront listés plusieurs modèles de moniteurs ( Voir figure 6-2).Si
votre moniteur a été détecté automatiquement, il sera affiché en tant que moniteur Plug’n Play,
dans la section concernant son modèle.
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Figure 6-2. Choisir un nouveau moniteur

Si votre moniteur n’est pas détecté automatiquement, choisissez le dans la liste. Si vous ne le trouvez pas (ou
un moniteur compatible), sélectionnez son équivalent dans la liste Générique, qui se situe en bas de la fenêtre.

6.2.2. Choisir une nouvelle résolution

Cet outil vous permettra de modifier la résolution actuelle de l’écran (800x600, 1024x768, etc.)
ainsi que le nombre de couleurs. Choisissez simplement celle que vous souhaitez utiliser.

Figure 6-3. Changer la résolution de votre écran
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Le moniteur dans la fenêtre montre à quoi ressemblera le bureau avec la configuration choisie (voir figure 6-3).
Les changements ne seront activés qu’après avoir quitté et relancé votre environnement graphique.

Moniteur et rapport de résolution. Par défaut, la liste des résolutions disponibles n’affiche que les résolutions
supportées par votre carte vidéo et votre moniteur. Il existe une entrée nommée Autres qui contient plus de
résolutions possibles, ainsi que leur rapport. Gardez à l’esprit que la plupart des moniteurs ont un rapport
horizontal sur vertical de 4:3.

6.2.3. Contrôler tous les paramètres vidéo

Si vous changez de carte vidéo après l’installation de votre système ou si vous désirez avoir le contrôle
total de votre configuration graphique, lancez cet outil en mode expert.

Figure 6-4. Fenêtre principale de XFdrake

Les premiers boutons permettent de changer certains paramètres de la configuration graphique :

Carte graphique

Le bouton contient le nom de la carte actuellement configurée. Si vous souhaitez la changer, cliquez des-
sus. Selon votre carte, plusieurs serveurs peuvent être disponibles, avec ou sans accélération 3D. Vous
devrez peut-être en essayer plusieurs avant d’obtenir le meilleur résultat.

Note : Suivant votre carte graphique, il peut vous être proposé d’utiliser un pilote propriétaire. Répondez Oui pour
utiliser le pilote fourni par le constructeur. Ce pilote pourra donner accès à plus de fonctionnalités et permettre de
meilleures performances pour les applications 3D, et notamment les jeux.

Si vous ne trouvez pas dans la liste la carte graphique que vous possédez, mais que vous connaissez le
pilote qui la supporte, sélectionnez-le dans le champ Xorg qui se trouve en bas.

Moniteur

Vous permet de changer de moniteur avec l’outil décrit dans la partie Choisir un nouveau moniteur, page
50.
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Résolution

Vous permet de changer la résolution de l’écran ainsi que le nombre de couleurs avec l’outil décrit dans
la partie Choisir une nouvelle résolution, page 51.

Changer la résolution avec l’applet du bureau : Si vous utilisez KDE, vous pouvez aussi changer la résolution
de l’écran à la volée en utilisant l’applet de redimensionnement d’écran, accessible depuis le menu principal Systè-
me+Configuration+Matériel→KRandRTray.

Il existe des boutons supplémentaires :

Test

Cliquez sur ce bouton pour vérifier que vos changements fonctionnent. Il est vivement recommandé de le
faire car si cela ne fonctionne pas, il sera plus difficile de récupérer un environnement graphique en bon
état. Si le test échoue, attendez simplement qu’il s’achève. Si l’échantillon du test ne vous a pas convaincu,
et que vous avez choisi Non pendant le test, vous retournerez au menu principal de XFdrake.

Si le test n’est pas possible : Selon votre carte vidéo, le test peut ne pas être possible. Vous en serez alors averti.
S’il s’avère que la configuration est mauvaise et que votre affichage est défectueux, lancez XFdrake en tant que
root pour utiliser la version texte de XFdrake.

Options

Options de la carte graphique

En fonction de votre carte graphique, vous pouvez choisir ici d’activer ou désactiver des fonctionna-
lités spécifiques telles que l’accélération 3D ou des effets spéciaux (la translucidité).

Interface graphique lors du démarrage

Cette option vous permet de choisir si vous voulez que votre machine démarre automatiquement
en mode graphique. Évidemment, il est préférable de choisir Non si vous êtes en train d’installer un
serveur, ou si vous n’avez pas réussi à configurer l’écran correctement.

Quitter

Si vous avez modifié votre affichage d’une quelconque façon, une liste présentant la configuration actuelle
sera affichée et XFdrake vous demandera si vous voulez sauvegarder vos modifications ou non. C’est votre
dernière chance pour revenir à l’ancienne configuration. Si tout semble correct, cliquez sur Oui. Si vous
souhaitez restaurer les anciens paramètres, cliquez sur Non.

Les changements seront effectifs uniquement après que vous les ayez validés et que vous aurez relancé votre
environnement graphique.

6.3. Configuration du bureau 3D

Cet outil est accessible depuis la section Matériel du Centre de contrôle Mandriva Linux. Il vous permet
de configurer un « bureau 3D » rendant des effets visuels étonnants. Il transforme votre bureau plat
classique en un bureau cubique.

Note : La première fois que vous lancez Drak3D, quelques paquetages devront être installés. Ensuite, la fenêtre principale
s’affiche (voir figure 6-5).
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Figure 6-5. Activation des effets du bureau 3D

Vous pouvez choisir entre quelques types de bureau avec effets spéciaux :

• Metisse ;

• Bureau 3D (espace cubique).

6.3.1. Metisse

Metisse est un gestionnaire de fenêtres développé par le projet In Situ (http://www-ihm.lri.fr/). Disponible
sous licence GPL, et exclusivement pour Mandriva Linux, Metisse diffère du bureau classique 3D (« le cube »,
voir Espace de travail cubique 3D, page 54) par son approche innovante de l’interaction avec les fenêtres.

Activation de Metisse. Cliquez sur OK pour installer les paquetages nécessaires, puis déconnectez-vous pour
activer le changement de bureau.

Une fois reconnecté, vous verrez un quadrillage de neuf cases en bas à droite du bureau. Ces dernières re-
présentent les neuf bureaux virtuels que vous pouvez utiliser pour organiser vos applications. Les fonctions
principales de Metisse sont détaillées dans .

6.3.2. Espace de travail cubique 3D

Choisissez l’option Bureau 3D (espace de travail cube) pour l’activer. Cliquez sur Advanced settings (ou réglages
avancés) pour vérifier les options (voir figure 6-5).

Configuration optionnelle

1. Choisissez un serveur graphique

Différentes approches existent : support natif et Xgl. Selon votre matériel, Drak3D sélectionne le plus ap-
proprié.

2. Choisissez un gestionnaire de fenêtres 3D

Quelques options sont disponibles : Compiz et Beryl. Le premier est plus simple et mieux testé, alors que
le deuxième propose plus de fonctionnalités. Voir la page du projet Beryl (http://www.beryl-project.
org/) pour plus de détails.
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Pour essayer ce bureau 3D, cliquez sur OK. Les changements prendront effet à la prochaine connexion.

Une fois le bureau 3D actif, le gestionnaire de fenêtres (KDE ou GNOME) comptera 4 bureaux virtuels corres-
pondant aux points de vue des faces du cube : explorez et appréciez votre nouveau bureau !

Consultez pour apprendre les raccourcis clavier et les manipulations avec la souris que vous pouvez utiliser
sur le bureau 3D.

6.3.3. Désactiver la 3D

Sélectionnez l’option Pas d’effets bureau 3D pour désactiver complètement le bureau 3D et revenir à votre
bureau traditionnel.

6.4. KeyboardDrake : changer votre type de clavier

Cet outil vous permet de définir une autre configuration de clavier, dans le cas où le clavier
que vous utilisez serait différent de celui choisi lors de l’installation.

Figure 6-6. Choix d’une autre configuration de clavier

Sélectionnez la disposition de votre clavier (associée à votre langue) puis son type (ou modèle) dans la liste
(figure 6-6). Si vous possédez un clavier multimédia et qu’il se trouve dans la liste de constructeurs, il y a de
bonnes chances que les touches multimédias soient prises en charge. Sinon, choisissez le type de votre clavier
dans la branche Générique. Les changements sont effectifs immédiatement après avoir cliqué sur OK.

Note : Si vous choisissez une configuration de clavier basée sur un alphabet non latin, une bôıte de dialogue vous demande
de choisir la combinaison de touches que vous souhaitez utiliser pour passer d’une configuration à l’autre.
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6.5. Changement de souris

Cet outil vous permet de paramétrer une autre souris, dans le cas où celle que vous utilisez actuelle-
ment est différente de celle choisie durant l’installation.

Note : La fonction Synaptics Touchpad est configurée automatiquement pour fonctionner avec la plupart des pavés
tactiles (touch pads) des ordinateurs portables. Il en va de même pour les tablettes Wacom®.

Figure 6-7. Choix d’une autre souris

Les souris sont classées en arborescence par type de connexion, puis par modèle (voir figure 6-7). Sélectionnez
la souris de votre choix, puis cliquez sur OK. Les changements effectués sont pris en compte immédiatement.

Astuce : L’option N’importe quelle souris PS/2 & USB fonctionne avec la plupart des souris récentes.

6.6. Configuration d’une imprimante

Cet outil vous permet de :

• configurer une imprimante nouvellement connectée sur votre machine ;

• configurer votre système pour servir une imprimante réseau connectée à votre réseau local ;

• permettre à votre machine d’accéder aux imprimantes réseau servies par d’autres serveurs .

6.6.1. Installation automatique

Si vous branchez une imprimante sur un port USB de votre ordinateur et vous l’allumez, un dialogue s’affiche :
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Figure 6-8. Une nouvelle imprimante a été détectée

Désactiver la détection automatique. Si vous ne voulez plus que le dialogue « installation automatique »
s’affiche, cochez Ne plus installer l’imprimante automatiquement.

Puis cliquez sur Ok, tous les paquetages requis seront installés et l’imprimante configurée, vous pouvez
l’utiliser tout de suite : il n’y a aucune autre manipulation à faire !

Configuration. Il est recommandé que vous vérifiez les paramètres par défaut de l’imprimante, particulière-
ment le format du papier. Pour cela, lancez PrinterDrake depuis le Centre de contrôle Mandriva Linux et suivez
les instructions de la Reconfiguration d’une imprimante, page 65.

6.6.2. Configuration manuelle

Astuce : Si vous venez d’installer une imprimante qui n’était pas disponible quand vous avez installé Mandriva Linux
assurez-vous qu’elle est correctement connectée et sous tension avant de lancer l’outil de configuration.

Lorsque vous lancez l’outil PrinterDrake pour la première fois, il peut s’afficher dans l’un des états suivants :

6.6.2.1. Aucune imprimante n’est directement connectée à l’ordinateur

Figure 6-9. Activation de l’impression
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L’outil n’a pas détecté d’imprimante locale. Cependant, vous pouvez imprimer sur une imprimante connectée
à une machine distante, ou configurer manuellement une imprimante qui n’aurait pas été détectée en cliquant
sur Oui.

Figure 6-10. Activation des imprimantes réseau

• Sélectionnez l’option système d’impression CUPS local si vous désirez que votre machine devienne un serveur
d’impression pour une imprimante locale ou connectée à votre réseau local.

Les logiciels nécessaires seront installés, puis l’interface principale de configuration (figure 6-12) apparaîtra.
Cliquez sur le bouton Ajouter une imprimante pour installer l’imprimante réseau.

• Sélectionnez l’option Serveur distant pour utiliser des imprimantes servies par un serveur d’impression
CUPS distant. Vos applications auront immédiatement accès à toutes les imprimantes publiques gérées par
ce serveur. Vous n’aurez qu’à fournir le nom d’hôte ou l’adresse IP de ce serveur dans le champ approprié
(renseignez-vous auprès de votre administrateur système).

Ensuite, l’interface principale de configuration (figure 6-12) apparaît et les imprimantes réseau disponibles
sont affichées dans l’onglet Configurée(s) sur d’autres machines.

6.6.2.2. Nouvelle imprimante détectée

La fenêtre suivante apparaît lorsque PrinterDrake détecte une imprimante au démarrage.
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Figure 6-11. Une nouvelle imprimante est détectée

Confirmez l’installation automatique de la nouvelle imprimante. L’interface principale de configuration
s’affiche (figure 6-12). Vérifiez que les paramètres de l’imprimante conviennent à vos besoins (Reconfiguration
d’une imprimante, page 65).

6.6.2.3. Une imprimante est déjà configurée

La fenêtre principale de configuration (voir figure 6-12) apparaît. Vérifiez que les paramètres de l’imprimante
conviennent à vos besoins (Reconfiguration d’une imprimante, page 65).

6.6.3. L’interface de gestion des imprimantes

Imprimante locales et distantes. Utilisez le premier onglet de l’outil de configuration d’imprimante pour les
imprimantes locales (Configurée(s) sur cette machine), et l’autre onglet pour les imprimantes disponibles sur le
réseau local (Configurées sur d’autres machines).
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Figure 6-12. Gestion des imprimantes

Les boutons suivants vous donnent accès à toutes les tâches de maintenance disponibles :

• Ajouter une nouvelle imprimante : pour lancer l’assistant de configuration des imprimantes décrit ici dans la
L’assistant de configuration d’imprimantes, page 63.

• Par défaut : désigne l’imprimante sélectionnée comme celle utilisée par défaut, lorsqu’aucune imprimante
particulière n’est sollicitée. Une croix apparaît dans la colonne Def. de cette imprimante.

• Éditer : ouvre le menu de configuration de l’imprimante (voir Reconfiguration d’une imprimante, page 65).

• Supprimer : enlève l’imprimante sélectionnée de la liste des imprimantes disponibles.

• Rafrâıchir : met à jour la liste des imprimantes , particulièrement utile pour les imprimantes réseau.

• Configuration de CUPS : par défaut, votre système est ouvert. PrinterDrake utilise toutes les imprimantes ac-
cessibles sur le réseau et partage toutes ses imprimantes locales. Cliquez sur ce bouton si vous ne souhaitez
pas imprimer sur des imprimantes du réseau, ou si vous voulez restreindre l’accès à vos propres impri-
mantes. Vous pouvez aussi y configurer l’accès à des serveurs d’impression en dehors du réseau local (voir
Configuration générale du serveur d’impression, page 60).

Note : La case à cocher du menu Options→Mode Expert donne accès à des fonctionnalités avancées (voir Mode Expert,
page 66).

6.6.4. Configuration générale du serveur d’impression

Le bouton Configurer CUPS vous permet de contrôler le comportement des imprimantes connectées sur votre
machine et au réseau.
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Figure 6-13. Configuration du serveur d’impressions CUPS

Ce dialogue vous permet de passer du mode d’impression client au mode serveur avec le bouton Serveur CUPS
distant et pas de démon CUPS local.

Ce bouton vous permet de choisir entre deux méthodes d’accès à un serveur distant.

Dans la première méthode, votre serveur doit avoir un démon CUPS en service et à l’écoute sur le port 631
pour gérer la file d’attente d’impression et écouter les tâches d’impression en provenance des applications.
Dans ce cas, le serveur CUPS signale sa présence à l’ensemble du réseau. C’est la configuration par défaut.

Dans la seconde méthode, le démon CUPS est toujours requis pour gérer la file d’impression et les gérer les
tâches arrivant sur le port 631, mais il ne signale pas sa présence sur le réseau. Dans ce cas, les clients n’ont
pas besoin d’exécuter le démon CUPS, en revanche ils ont une configuration de fichiers qui contient l’adresse
IP du serveur. De cette façon, les clients savent qu’ils peuvent transmettre des tâches directement à l’adresse
IP.

Avantages Inconvénients

Méthode 1 Aucune configuration de client
requise

Fonctionne avec au moins un port
ouvert et consomme des
ressources système
supplémentaires

Méthode 2 Aucun système d’impression local.
Aucun port ouvert.

Si l’adresse IP du serveur change,
ou si les clients changent de
réseau, alors une reconfiguration
est nécessaire.

Tableau 6-1. Considérations
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6.6.4.1. Mode client

Figure 6-14. Configuration du mode client

Sélectionnez l’option Actif pour vous connecter à un autre serveur d’impression. Il ne vous reste plus qu’à
spécifier le nom ou l’adresse IP de ce serveur dans le champ au-dessous.

Si vous choisissez ce mode, votre configuration est terminée. Acceptez les options en cliquant sur le bou-
ton OK, et vous pourrez consulter la liste des imprimantes disponibles dans l’onglet Configurées sur d’autres
machines de l’interface principale (voir figure 6-12).

6.6.4.2. Mode serveur

Si vous souhaitez que votre machine puisse accéder aux imprimantes connectées localement (sur un port
parallèle ou USB), ou aux imprimantes réseau qui ne sont pas déjà prises en compte par un autre serveur,
vous devez sélectionner l’option Désactivé. Cliquez sur OK pour configurer votre serveur d’impression (voir
figure 6-13).

Plusieurs options sont alors proposées pour sécuriser et améliorer les performances de votre serveur :

Les imprimantes de cette machine sont disponibles aux autres ordinateurs

Permet à d’autres ordinateurs d’imprimer sur vos imprimantes configurées localement. Pour en restrein-
dre l’accès, cliquez sur Partage d’imprimantes sur les hôtes/réseaux (voir ci-dessous).

Trouver automatiquement des imprimantes disponibles sur des machines distantes

Indique à votre serveur d’impression de rendre disponible toutes les autres imprimantes trouvées sur
les autres serveurs du réseau local, comme si elles étaient directement connectées à votre serveur
d’impression. De cette façon, les utilisateurs de votre serveur d’impression pourront imprimer sur toutes
les imprimantes que le serveur « voit », qu’elles soient locales ou distantes. Si les imprimantes distantes
que vous souhaitez utiliser sont servies par un serveur ne faisant pas partie de votre réseau local, vous
pouvez spécifier manuellement son adresse grâce au bouton Serveurs CUPS additionnels (voir ci-dessous).

Partage d’imprimantes sur les hôtes/réseaux

Permet de spécifier quels réseaux ont accès aux imprimantes locales.

Serveurs CUPS additionnels

Permet de spécifier un ou plusieurs serveurs CUPS sur lesquels vous pouvez vous connecter et accéder
aux imprimantes. Spécifiez l’adresse IP et le port du serveur CUPS dans le dialogue qui apparaît.
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Mode d’impression du texte japonais

Remplace le filtre texte original par un autre plus approprié aux textes en japonais, mais avec moins de
fonctionnalités. Utilisez cette option si vous devez imprimez des fichiers texte en japonais.

6.6.5. L’assistant de configuration d’imprimantes

Cliquez sur le bouton Ajouter une imprimante et l’assistant de configuration apparaît.

6.6.5.1. Détection d’une imprimante ou spécification du chemin d’accès

La première étape permet soit de spécifier un chemin d’accès à une imprimante réseau, soit d’activer la détec-
tion automatique des imprimantes locales, réseau, ou servies par un serveur SMB (Windows®).

Figure 6-15. Type de connexion de l’imprimante

Spécification du chemin. Si vous connaissez tous les paramètres requis pour accéder à une imprimante ré-
seau particulière, sélectionnez Entrer le nom de l’hôte/l’adresse IP de l’imprimante réseau. Ensuite, les étapes de
configuration sont similaires à celles de la procédure de détection automatique.

6.6.5.2. Choix de l’imprimante

Figure 6-16. Liste des imprimantes détectées

1. Choisissez l’imprimante à configurer
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Choisissez l’imprimante que vous voulez ajouter depuis la liste. Si celle détectée n’est pas la bonne, cochez
la case Sélectionner manuellement le modèle et poursuivez vers l’étape de sélection du modèle d’imprimante.
Si la détection automatique échoue, décochez toutes les cases, cliquez sur Suivant et suivez les instructions.

2. Spécifier le pilote manuellement

PrinterDrake affiche le nom du modèle de votre imprimante. Choisissez Sélectionner le modèle manuellement
si le modèle proposé est incorrect. Sélectionnez votre imprimante ou une autre compatible (voir Choix de
l’imprimante, page 63) si la vôtre n’apparaît pas dans la liste.

3. Pilote fourni par le fabriquant

Si vous voulez installer le pilote fourni par le fabriquant de votre imprimante, cliquez sur le bouton Installer
un fichier PPD fourni par le fabriquant et sélectionnez le support contenant le fichier PPD et naviguez jusqu’à
ce fichier. Acceptez les choix proposés dans les dialogues suivants pour utiliser le fichier PPD choisi.

4. Imprimante multifonction HP

Si vous possédez une imprimante multifonction telle que celles de HP ou Sony, une fenêtre informative
apparaît et vous renseigne au sujet de votre scanner et des logiciels associés (Installation et partage du
scanner, page 66). Des paquetages supplémentaires sont aussi installés.

Imprimante virtuelle Fax. Si votre imprimante possède également une fonction fax, vous avez la possibi-
lité de créer une imprimante fax virtuelle qui mettra en attente les documents imprimés pour qu’ils soient
télécopiés ultérieurement.

5. Étape de configuration optionnelle

Si votre imprimante possède des accessoires en option (finitions, bac d’alimentation papier supplémen-
taire, etc.), précisez lesquels sont actuellement installés.

6.6.5.3. Test d’impression

Plusieurs pages de test sont disponibles (figure 6-17). Il est préférable d’imprimer au moins une page de
test tout de suite afin de modifier éventuellement les paramètres erronés. L’impression de cette page de test
commence presque immédiatement.

Figure 6-17. Test de l’impression
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6.6.5.4. C’est fini

Si l’impression s’est mal déroulée, répondez par Non pour revenir au menu de configuration de l’imprimante
(figure 6-18) et modifier ses paramètres. Voir Reconfiguration d’une imprimante, page 65.

Votre imprimante apparaît désormais dans la liste d’imprimantes configurées de la fenêtre principale (figure
6-12).

6.6.6. Reconfiguration d’une imprimante

En faisant un double-clic sur le nom d’une imprimante ou en cliquant sur le bouton Éditer, un menu appa-
raît, permettant de modifier la configuration de l’imprimante (figure 6-18). Vous pouvez modifier le nom de
l’imprimante, ses options, etc.

Figure 6-18. Modification d’une imprimante

Voici les options les plus pratiques :

• Nom, description, emplacement. Si vous avez plusieurs imprimantes, il est préférable de leur donner un nom
explicite, une description pertinente, et d’en indiquer l’emplacement, pour que les usagers ne se retrouvent
pas à chercher désespérément leurs impressions à tous les étages.

• Options de l’imprimante. Affiche les différentes options disponibles pour cette imprimante (format du papier,
mode d’impression, etc.), pour en définir les valeurs par défaut.

• Rendre l’imprimante invisible pour les autres ordinateurs. Les imprimantes sont normalement rendues accessi-
bles aux autres ordinateurs du réseau local. En utilisant cette option, vous désactivez ce comportement pour
l’imprimante sélectionnée.

• Désactiver l’imprimante. Utilisez cette option pour supprimer une imprimante de la liste des imprimantes dis-
ponibles des utilisateurs système. Vous pourriez avoir besoin de désactiver temporairement une impriman-
te en maintenance pour éviter son utilisation pendant cette période. Lorsqu’une imprimante est désactivée,
cette option devient Activer l’imprimante.

• Savoir comment utiliser cette imprimante. Affiche des informations sur la manière d’utiliser l’imprimante.
Dans le cas d’une imprimante multifonction HP ou autre, l’acquisition ou l’accès aux cartes mémoire est
aussi documenté.

• Supprimer l’imprimante. Si vous souhaitez supprimer une imprimante de votre système.

Sélectionnez une option dans la fenêtre et cliquez sur le bouton Faire.
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6.6.7. Contrôler les installations automatiques

Cliquez sur le menu Options→Configurer l’administration automatique pour afficher le formulaire d’options
d’installation automatique.

Figure 6-19. Définir les options d’installation automatique

C’est ici que vous pouvez définir si les nouvelles imprimantes doivent être automatiquement détectée, confi-
gurée, etc.

6.6.8. Mode Expert

Le mode expert active des fonctionnalités supplémentaires :

Assistant d’installation plus technique. L’assistant d’installation affiche des informations plus techniques
et vous permet de configurer le nom de l’imprimante ainsi que d’autres options directement à partir de
l’assistant.

Choix d’un pilote différent du pilote par défaut. Plusieurs pilotes sont généralement disponibles pour
une même imprimante. En mode expert, un troisième niveau apparaît dans l’arborescence de sélection de
l’imprimante (Choix de l’imprimante, page 63) permettant de modifier le pilote associé à une imprimante.

Pas de configuration automatique. Si PrinterDrake est en mode expert, il ne configure pas automatiquement
les nouvelles imprimantes locales au démarrage. Utilisez le bouton Ajouter une imprimante pour ce faire. Tou-
tefois, vous pouvez choisir le mode Configure Auto Administration depuis le menu Options pour annuler ce
comportement.

Correction automatique de la configuration du serveur CUPS. Cette nouvelle option apparaît dans la fenêtre
de configuration du serveur CUPS (figure 6-13. Elle est activée par défaut. Laissez la souris sur le nom de
l’option pour avoir plus d’information sur sa fonction.

6.7. Installation et partage du scanner

L’assistant ScannerDrake vous aide à installer votre scanner. Assurez-vous que votre scanner
est sous-tension et lancez ScannerDrake en cliquant sur Scanners dans la catégorie Matériel du
Centre de contrôle Mandriva Linux.

66



Chapitre 6. Réglage matériel

Astuce : Notez que tous les scanners ne sont pas supportés sous GNU/Linux. Avant d’acheter un nouveau périphérique,
vérifiez la Base de données HCL de Mandriva (http://hcl.mandriva.com) (en anglais) et le site Internet de SANE
(http://www.sane-project.org/) pour connâıtre les problèmes de compatibilité.

6.7.1. Interface principale et installation du scanner

Le programme tente de détecter le fabriquant et le modèle de votre scanner. S’il trouve le scanner, des informa-
tions le concernant sont affichées dans la partie supérieure de la fenêtre principale de l’assistant. Cette fenêtre
présente aussi quelques boutons d’action. (figure 6-20).

Figure 6-20. Installation de votre scanner

Rechercher des nouveaux scanners

Cliquez sur ce bouton pour détecter automatiquement un nouveau scanner que vous aurez préalablement
branché.

Ajouter manuellement un scanner

Utilisez ce bouton si la détection automatique échoue et recherchez le modèle spécifique de scanner que
vous possédez en parcourant la liste des modèles disponibles.

Figure 6-21. Arborescence de tous les modèles de scanners connus

67

http://hcl.mandriva.com
http://www.sane-project.org/


Chapitre 6. Réglage matériel

Choisissez le port adéquat. Après avoir choisi le modèle approprié, vous pouvez laisser les paramètres par
défaut de l’option Détecter automatiquement les ports disponibles à moins que votre scanner ne soit équipé d’un
port parallèle, auquel cas vous devez choisir /dev/parport0 dans la liste déroulante.

Imprimantes multifonction HP

Notez que les imprimantes multifonction d’HP, telles que les modèles OfficeJet et PSC doivent être configurées
à l’aide de PrinterDrake. Reportez-vous à Configuration d’une imprimante, page 56. La fonction scanner des
imprimantes multifonction autres qu’HP peut être configurée avec ScannerDrake, en tant que scanner autonome.

6.7.2. Partage de votre scanner

ScannerDrake permet aux utilisateurs connectés via un LAN de partager le même scanner.

Figure 6-22. Partage de scanner à l’intérieur d’un LAN

Partagez votre propre scanner

1. Cochez la case Les scanners de cette machine sont utilisables par les autres ordinateurs.

2. Cliquez sur le bouton Partage de scanners pour les hôtes puis sur Ajouter les hôtes pour spécifier quels hôtes
seront autorisés à accéder à votre scanner.

Utiliser le scanner des autres

1. Cochez la case Utiliser des scanners sur des ordinateurs distants.

2. Cliquez sur le bouton Utilisez les scanners sur les hôtes puis sur Ajouter les hôtes pour spécifier quels hôtes
servent le scanner que vous souhaitez utiliser.
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6.8. Paramétrage de votre UPS

Cet outil configurera pour vous le service NUT (Network UPS Tool). Ce service vérifie l’UPS connecté
à votre machine et l’éteint automatiquement quand sa batterie est presque épuisée.

Installation Automatique. Ouvrez le Centre de contrôle Mandriva Linux, puis la catégorie Matériel et cliquez
sur Configurer un onduleur (UPS) pour la surveillance du courant électrique pour lancer DrakUPS. Cochez l’option
Connecté via un port série ou un câble USB pour laisser DrakUPS détecter automatiquement votre UPS.

Configuration manuelle (Port série)

1. Sélectionnez l’option Configuration manuelle.

2. Sélectionnez votre UPS parmi la liste de fabricants et de modèles.

3. Puis, assignez-lui un Nom, un Pilote, et un Port1.

Si tout s’est bien passé, votre UPS devrait maintenant être configuré et prêt à vous aider à éviter les mauvaises
surprises dues aux coupures de courant.

1. Les champs Nom et Pilote devraient être automatiquement remplis. Bien sûr, vous pouvez changer son nom, mais
nous vous recommandons de conserver le nom du pilote.
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7.1. Gestion des connexions réseau et Internet

Astuce : Avant de vous connecter à Internet, il est conseillé de configurer un pare-feu sur votre machine, pour éviter
de mauvaises surprises comme des intrusions. Vous pouvez mettre en place un pare-feu simple et efficace en utilisant
DrakFirewall (voir la DrakFirewall : configuration d’un pare-feu élémentaire, page 95 pour plus de renseignements).

L’ensemble d’outils drakconnect facilite la configuration et la maintenance de vos accès réseau, que ce soit sur
Internet ou un réseau local. Pour lancer drakconnect, ouvrez le Centre de contrôle Mandriva Linux et cliquez
sur Réseau & Internet. À partir de là, plusieurs utilitaires vous permettent de configurer et de superviser les
connexions réseau. L’interface principale est reproduite dans la figure 7-1.

Figure 7-1. Outils DrakConnect

7.1.1. Nouvelle connexion

drakconnect peut gérer plusieurs sortes de connexions réseau et Internet. La première étape
consiste à choisir le type de connexion que vous souhaitez utiliser. Assurez-vous que vous avez
sous la main toutes les informations fournies par votre fournisseur d’accès à Internet ou votre
administrateur réseau.

Note : Une fois la connexion configurée, elle peut être modifiée en utilisant l’interface Gérer les connexions (voir Recon-
figuration d’une interface, page 75).

7.1.1.1. Configuration d’une connexion Ethernet

1. Sélectionnez la connexion de type Ethernet
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Vos interfaces réseau sont détectées automatiquement : si vous en possédez plus d’une, vous devez sélec-
tionner celle que vous souhaitez configurer. Vous pouvez aussi charger un pilote de périphérique (driver)
manuellement.

2. Configuration automatique ou statique

Vous devez maintenant spécifier si les paramètres réseau seront attribués automatiquement (Attribution
automatique de l’adresse IP (BOOTP/DHCP)) ou non (Configuration manuelle) : remplissez les champs sui-
vants avec les informations fournies par votre FAI ou votre administrateur réseau.

3. Contrôle de la connexion

Autoriser les utilisateurs à gérer la connexion

Si vous souhaitez que les utilisateurs puissent activer ou fermer la connexion, sans avoir besoin de
fournir le mot de passe root (voir Surveillance des connexions, page 76) cochez cette case.

Lancer la connexion au démarrage

Décochez cette case si vous voulez que la connexion soit activée à la demande uniquement.

L’applet réseau : Une applet apparâıt sur le tableau de bord indiquant que la connexion est active

ou inactive

. Faites un clic droit pour accéder à un menu depuis lequel vous pourrez contrôler l’état de votre connexion ainsi
que d’autres paramètres.

7.1.1.2. Connexion sans fil

Cet outil permet de configurer les cartes réseau sans fil (WiFi) PCMCIA ou PCI.

1. Choisissez votre interface WiFi

Si votre carte Wifi n’est pas dans la liste, choisissez l’option Utiliser un pilote Windows . A l’étape suivante,
vous devez sélectionner le pilote à partir du CD du fabricant de la carte.

2. Choisissez le réseau

Une liste des réseaux qui ont été détectés apparaît. Sélectionnez le vôtre, sinon l’option non-listé?.

3. Paramétrage de la connexion sans fil

Mode de fonctionnement

Le mode dans lequel la carte fonctionnera par rapport aux autres équipements Wifi du réseau; Le
plus courant est Géré pour se connecter simplement à un point d’accès existant.

Nom de réseau (ESSID)

Le nom du réseau auquel vous souhaitez vous connecter. Demandez à votre administrateur réseau.

Mode de chiffrement

Ceci dépend des paramètres du réseau, demandez-les à votre administrateur réseau.
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Clé de chiffrement

Ceci dépend aussi des paramètres du réseau, demandez à votre administrateur la clé utilisée pour le
réseau choisi.

4. Configuration du réseau

Ceci est similaire à la configuration d’un réseau Ethernet classique : Configuration d’une connexion Ethernet,
page 71.

5. Contrôle de la connexion

Cochez la case Autoriser l’itinérance si vous souhaitez que la connexion passe automatiquement d’un point
d’accès à l’autre, en fonction de la force du signal. Ceci est particulièrement utile lorsque vous êtes en
déplacement avec votre portable.

Gestion des connexions. Consultez Gestion des connexions sans-fil, page 79 pour apprendre comment configu-
rer et gérer plusieurs réseaux sans-fil.

7.1.1.3. Connexion RNIS/ISDN

Sélectionnez les bons paramètres dans toutes les étapes concernant votre zone géographique et votre fournis-
seur.

La dernière étape propose de vous permettre de gérer la connexion à l’aide de l’applet réseau, ce qui peut être
utile si vous n’avez besoin de la connexion que de temps en temps.

7.1.1.4. Connexion par modem (POTS)

1. Une liste des modems détectés est affichée. Si celui que vous désirez configurer n’a pas été détecté auto-
matiquement, cochez la case Choix manuel. Ensuite, choisissez le port auquel le modem est connecté. Les
paquetages requis seront installés.

2. Une liste de pays/FAI apparaît. Si votre fournisseur d’accès y est affiché, sélectionnez-le et passez à l’étape
suivante : certains paramètres (nom de la connexion, numéro de téléphone et l’authentification) seront
automatiquement configurés. Dans le cas contraire, choisissez l’option Non listé - éditer manuellement.

3. Vérifiez les paramètres et entrez les paramètres manquants, qui vous ont été fournis par votre FAI.

Figure 7-2. Saisie des paramètres de la connexion modem classique

La plupart des paramètres sont évidents, à l’exception du type d’authentification. La liste déroulante Au-
thentification donne accès au protocole supporté par votre fournisseur : Basée sur un script (une ancienne
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méthode basée sur une communication entre votre système et le FAI), Manuelle par terminal (une fenêtre
de terminal s’affiche de façon à pouvoir se connecter de manière interactive), PAP, CHAP, ou PAP/CHAP
(protocoles d’échange d’information d’authentification, CHAP est préférable car plus sûr, PAP/CHAP
choisira automatiquement le protocole approprié).

4. Viennent alors les paramètres IP, DNS et passerelle. La plupart des fournisseurs d’accès permettent de
configurer cela automatiquement, il suffit donc de cocher l’option Automatique.

5. Contrôle de la connexion

Autoriser les utilisateurs à gérer la connexion

Vous devez alors indiquer si vous souhaitez que les utilisateurs puissent démarrer une connexion. Ils
pourront alors le faire sans avoir besoin du mot de passe root.

Lancer la connexion au démarrage

Il est probablement plus sûr et moins cher de répondre Non.

6. Finalement, il est proposé de tester la connexion. Nous vous recommandons de le faire pour vous assurer
que tous les paramètres sont corrects. Vous pouvez maintenant contrôler l’état de votre connexion Internet
en utilisant l’applet réseau. Il est aussi possible d’utiliser le contrôleur de connexion Internet par accès à
distance (kppp) en choisissant : Internet+Accès distant→K PPPà partir du menu principal.

7.1.1.5. Connexion DVB

Ce type de connexion est utilisé pour les liaisons par satellite.

1. Choisissez la carte à configurer, puis fournissez les paramètres de l’adaptateur.

2. La configuration réseau est alors similaire à la connexion de type réseau local (voir la Configuration d’une
connexion Ethernet, page 71).

7.1.1.6. GPRS/Edge/3G

Ce type de connexion gère les connexion à Internet par téléphone cellulaire, accessibles par une carte PCM-
CIA. La technologie Troisième Génération (3G), ainsi que d’autres plus anciennes (GPRS/Edge) sont prises en
charge. La prise de la norme plus récente HSDPA est aussi disponible.
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7.1.2. Réglages Internet

Figure 7-3. Configuration de l’accès à Internet

Cette interface permet de spécifier les paramètres d’accès à Internet dans le cas où ils devraient être ajustés
après la configuration initiale. Ces paramètres sont appliqués au système dans son entier et sont donc partagés
par toutes les interfaces. Si nécessaire, l’adresse de la passerelle devra être modifiée comme il est expliqué dans
la Reconfiguration d’une interface, page 75.
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7.1.3. Reconfiguration d’une interface

Figure 7-4. Gestion des connexions réseau

Cet outil permet de modifier les paramètres propres à chaque interface (Nouvelle connexion, page
71). Utilisez la liste déroulante pour choisir l’interface à reconfigurer. Les onglets permettent alors
de changer les paramètres et options propres à chaque interface.
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7.1.4. Surveillance des connexions

Figure 7-5. Surveillance des connexions réseau en temps réel

Cet écran affiche l’activité des interfaces réseau. Il est possible de personnaliser les options du
graphique (voir figure 7-5). Il peut aussi être utilisé pour modifier l’état d’une connexion réseau,
en l’activant ou la désactivant (bouton en bas à gauche).

Note : L’interface de surveillance du réseau peut être activée par les utilisateurs avec l’applet réseau, pour visualiser le
trafic.

7.1.5. Suppression d’une connexion

Cet outil propose simplement de supprimer les paramètres de configuration d’une interface. Il
suffit de sélectionner l’interface à supprimer dans la liste déroulante.

Avertissement

Il ne sera pas demandé de confirmation pour la suppression d’une interface. Une fois l’interface sélectionnée, une
seule pression sur le bouton Suivant suffit à la supprimer.

7.1.6. Paramètres de la passerelle (Proxy)

Si votre connexion Internet doit (ou peut) passer par un proxy, cet outil permet de spécifier le nom
d’hôte ou l’adresse IP des passerelles pour les protocoles FTP et HTTP que votre ordinateur doit
utiliser. Remplissez les champs puis cliquez sur OK.

Ce qu’est un proxy. Un serveur mandataire, ou passerelle (en anglais proxy, connu également sous le nom de
« serveur de proximité ») va chercher des informations sur Internet à votre place. La plupart des serveurs man-
dataires conservent une copie locale des pages Web le plus souvent demandées. On appelle de tels serveurs
mandataires des « serveurs cache » et ils permettent de meilleures performances. Dans certaines entreprises et
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administrations, vous ne pouvez pas accéder directement à Internet, mais vous devez passer par un serveur
mandataire. Le pare-feu de l’entreprise ou de l’administration ne permet d’accéder directement à Internet
qu’au serveur mandataire, en général pour des raisons de sécurité.

7.2. Activation et gestion des profils réseau

Le système de profils du Centre de contrôle Mandriva Linux vous permet de conserver différents types de
configurations sur votre machine, en fonction par exemple, de différents lieux. C’est particulièrement utile
pour les ordinateurs portables qui changent sans cesse de configuration entre la maison, le bureau, le café, etc.
Les paramètres qui peuvent changer d’un profil à l’autre sont :

La configuration du réseau

Activer différentes interfaces, avec différentes configurations, pour le réseau sans-fil par exemple.

La configuration des services

Cela vous permet d’activer différents services d’un profil à l’autre, par exemple, un pare-feu à votre do-
micile et aucun pare-feu à votre bureau (voir Configuration des services au démarrage, page 81).

7.2.1. Gestion des profils

Lorsque vous créez un nouveau profil, il est basé sur le profil actif. Toutes les modifications sont automatique-
ment enregistrées dans le profil actif. Un simple menu (Profils) vous permet de les gérer.

Figure 7-6. L’interface des profils réseaux

Activer

Active le profil sélectionné.

Dupliquer

Crée un nouveau profil basé sur les paramètres du profil actif. Une boîte de dialogue apparaît pour de-
mander le nom du nouveau profil. N’oubliez pas d’activer ce profil après l’avoir créé si vous souhaitez le
configurer.
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Supprimer

Supprime le profil sélectionné, sans afficher d’autre message. Notez qu’un message d’avertissement ap-
paraît lorsque vous tentez de supprimer le profil actif, parce qu’il ne peut pas être supprimé lorsqu’il est
utilisé.

Le profil default. C’est ce profil qui est utilisé au démarrage. Il ne peut être pas supprimé.

Exemple : Créer un nouveau profil pour vous connecter de votre domicile avec un modem RTC. Vous rentrez
chez vous avec votre ordinateur portable flambant neuf que votre administrateur système a configuré pour
que vous puissiez vous connecter au réseau de votre entreprise. Vous souhaitez à présent pouvoir configurer
le réseau pour accéder à Internet de votre domicile avec un modem RTC.

1. Créez un nouveau profil appelé par exemple, « Home ».

2. Passez à celui-ci.

3. Reconfigurez votre réseau pour que le modem (au lieu de la carte réseau) soit utilisé pour accéder à
Internet (voir Gestion des connexions réseau et Internet, page 71).

4. Connectez-vous à Internet.

5. Quand vous retournez au bureau, repassez au profil « default ».

7.3. Gestion des connexions sans-fil

Cet outil affiche les réseaux sans-fil actuellement disponibles. Il vous permet aussi de passer
d’un réseau à l’autre et de modifier leur configuration. Si vous n’avez pas encore configuré votre
interface sans-fil, reportez-vous à Connexion sans fil, page 72 pour plus de renseignements. La
figure 7-7 montre l’interface de DrakRoam : une liste des réseaux disponibles avec leurs statuts, et

des boutons d’action au-dessous.

Astuce :

Vous pouvez également faire un clic droit sur l’icône de puissance du signal dans le panneau et choisir
Réseaux sans fil+Gérer les réseaux sans fil, puis taper le mot de passe root pour accéder à l’outil.

Figure 7-7. Interface de DrakRoam

La liste des réseaux détectés s’affiche. Si vous voulez trouver d’autres réseaux, cliquez Rafraichir.
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7.3.1. Changement de réseau

Pour changer de réseau, sélectionnez-en un dans la liste, puis cliquez Connecter. Si le réseau est public, vous
serez immédiatement connecté. Si le réseau est privé, un dialogue tel que celui de figure 7-8 vous demandera
les paramètres de configuration. Entrez les paramètres requis (en particulier la clé de chiffrement) et cliquez
sur OK. Les réglages prennent effet immédiatement.

7.3.2. Configuration d’une connexion sans-fil

Si vous devez changer les paramètres du réseau, il vous suffit de sélectionner le réseau dans la liste, puis de
cliquer sur le bouton Configurer. Voir figure 7-8 pour un exemple de connexion sans fil sécurisée.

Figure 7-8. Modification des paramètres du réseau sans-fil

Faites vos changements et cliquez OK. Les changements prendront effet immédiatement. Cliquez Avancé pour
régler des paramètres tels que l’identifiant réseau ou la fréquence utilisée.
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8.1. Configuration des services au démarrage

Au démarrage, plusieurs services (programmes exécutés en tâche de fond pour réaliser de
nombreuses tâches) sont lancés. Cet outil permet à l’administrateur de contrôler ces services.
Consultez le chapitre du Manuel de Référence sur Les fichiers de démarrage : init sysv pour obtenir
plus d’information..

Figure 8-1. Choix des services disponibles au démarrage

Pour chaque service, voici la liste des éléments énumérés :

• Nom du service.

• État actuel : soit actif, soit arrêté.

• Information : en cliquant sur ce bouton, vous obtiendrez une description de ce service.

• Au démarrage : cochez cette case si vous souhaitez que ce service soit disponible lors du démarrage. 1 Si
le service choisi est un service xinetd, l’option Démarré si nécessaire sera affichée. En cochant cette case, le
service sera géré par xinetd. Vous devrez alors vous assurer que ce dernier est lui-même activé.

• Démarrer : démarre immédiatement un service, ou le relance (arrêt et démarrage) s’il était déjà activé.

• Arrêter : arrête immédiatement le service.

Quand vous cliquez sur le bouton Démarrer ou Arrêter, une info-bulle vous indique l’état du service.

1. En général dans lesrunlevels niveaux d’exécution (runlevels) 3 et 5.
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8.2. Gestion des polices de caractères avec DrakFont

Cet outil vous permet de contrôler les différents styles, les familles et tailles de police de carac-
tères disponibles sur votre système. L’administrateur peut également y installer de nouvelles
polices.

La fenêtre principale (figure 8-2) donne un aperçu visuel de la configuration de police sélectionnée.

Figure 8-2. La fenêtre principale de DrakFont

drakfont est constitué de plusieurs écrans accessibles grâce aux boutons situés en bas.

Obtenir les polices Windows

Ce bouton ajoute automatiquement les polices trouvées sur les partitions Windows® de votre disque dur,
si elles existent.

Options

Vous permet de spécifier quelles applications ou quels périphériques (comme les imprimantes) utiliseront
les polices de caractères. Sélectionnez les polices qui seront utilisées et cliquez sur le bouton OK.

Désinstaller

Permet de supprimer des polices installées, de façon à gagner de la place sur le disque dur par exemple.
Utilisez ce bouton avec précaution, car il peut y avoir des répercussions fâcheuses sur vos applications.
Ne désinstallez pas des polices que vous n’avez pas installées vous-même.

Ce bouton supprime toutes les polices trouvées dans un répertoire donné. Notez que les polices ajoutées
manuellement avec drakfont se trouvent dans /usr/share/fonts/drakfont/
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Importer

Permet d’ajouter des polices récupérées hors de la distribution Mandriva Linux, sur un CD de polices que
vous avez acheté ou sur Internet, par exemple. Les formats de polices supportés sont ttf, pfa, pfb, pcf,
pfm, gsf. Si vous cliquez sur Ajouter, un dialogue standard apparaît, vous permettant de choisir le fichier
de police à importer. Une fois que vous avez choisi toutes les polices que vous voulez importer, cliquez
sur le bouton Installer les polices.

Sélection de plusieurs polices : Pour sélectionner plusieurs polices, appuyez sur CTRL maintenez cette touche
enfoncée tout en sélectionnant les polices que vous voulez installer et cliquez sur OK : elles seront ajoutées dans la
fenêtre Importer des polices. Puis, cliquez sur le bouton Installer les polices.

Note : Quand vous ajoutez ou supprimez des polices, les modifications peuvent ne pas être visibles immédiatement dans
la liste de polices. Fermez et relancez drakfont pour vous assurer que vos modifications ont bien été prises en compte.

8.3. Réglage de la date et de l’heure de votre ordinateur

Ce petit outil permet de configurer la date et l’heure interne de votre système.

Figure 8-3. Changement de la date et de l’heure

Vous pouvez changer la date à gauche, et l’heure à droite :

1. Date

Pour changer l’année, cliquez sur les petites flèches de chaque côté de l’année ; faites de même pour
changer le mois. Cela met à jour le calendrier du mois en dessous, où vous pourrez cliquer sur la date du
jour pour la mettre en surbrillance.
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2. Fuseau Horaire

Il est recommandé de vérifier que la configuration du fuseau horaire est conforme à votre emplacement
géographique. Cliquez sur le bouton Changer le fuseau horaire et sélectionnez l’emplacement correct dans
la liste.

Lorsque vous avez choisi le fuseau horaire, un dialogue apparaît vous demandant si votre horloge système
est réglée sur Greenwich (GMT). Répondez Oui si GNU/Linux est le seul système installé sur cette machine,
Non dans le cas contraire.

3. Heure

Pour changer l’heure, vous pouvez soit bouger les aiguilles des heures, minutes et secondes à la souris;
soit modifier les chiffres correspondants en dessous.

4. Synchronisation automatique de l’horloge

Si vous possédez une connexion Internet permanente et que vous désirez que votre système synchronise
son horloge interne avec des serveurs de synchronisation horaire en réseau, cochez la case Activer NTP et
choisissez un Serveur, de préférence près de chez vous, dans la liste déroulante. Si vous connaissez le nom
ou l’adresse IP d’un serveur local, vous pouvez aussi l’entrer manuellement.

Lorsque vous avez terminé, cliquez sur OK pour appliquer vos changements, ou Annuler pour fermer l’outil,
et renoncer aux changements. Si vous souhaitez revenir à la configuration en vigueur sur le système, cliquez
sur Réinitialiser.

8.4. Surveillance de l’activité du système

Cet outil permet de rechercher des lignes particulières dans un ou plusieurs fichiers journaux (log),
facilitant ainsi la recherche d’incidents particuliers ou de problèmes de sécurité.

8.4.1. Consultation des journaux du système

Figure 8-4. Consultation et recherches dans les fichiers journaux
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Pour faire une recherche parmi les fichiers journaux, voici les étapes à suivre: :

1. Termes à rechercher

Vous devez choisir entre rechercher les lignes qui ne contiennent qu’un mot particulier en remplissant le
champ Contenant ; et/ou celles qui ne contiennent pas tel mot en remplissant le champ mais ne contenant
pas.

2. Fichier journal

Vous devez ensuite choisir le fichier sur lequel vous souhaitez lancer la recherche, dans la zone Choisir le
fichier ; il suffit de cocher la case correspondante.

Note : Le journal Actions des Outils Mandriva Linux est écrit par les outils de configuration Mandriva Linux, comme
ceux qui font partie du Centre de contrôle Mandriva Linux. Chaque fois que ces outils modifient la configuration du
système, ils le signalent dans ce journal.

3. Date de l’événement

Vous pouvez éventuellement restreindre la recherche à un jour particulier. Dans ce cas, cochez la case Ne
montrer que pour ce jour,puis choisissez le jour désiré dans le calendrier sur la droite.

4. Recherche

Quand tout est configuré, cliquez sur le bouton chercher. Le résultat apparaîtra dans la liste contenu du
fichier, en bas.

En cliquant sur le bouton Valider, vous pourrez enregistrer les résultats de votre recherche dans un fichier texte
(*.txt).

8.5. Gestion des utilisateurs et des groupes

UserDrake est un utilitaire évolué qui permet à l’administrateur système d’ajouter et de supprimer facilement
des utilisateurs, de les assigner à des groupes et de manipuler ces groupes de la même manière.

Note : Dans cette section, nous nous concentrons uniquement sur la gestion des utilisateurs ; la manipulation des groupes
est très similaire.

8.5.1. L’interface

Au lancement, UserDrake affichera la fenêtre principale (figure 8-5), qui liste les utilisateurs qui ont été créés
sur le système. Vous pouvez lier des utilisateurs à des groupes en activant l’onglet Groupes à droite de celui
des Utilisateurs.

85



Chapitre 8. Personnalisation de votre système

Figure 8-5. La liste des utilisateurs dans UserDrake

Tous les changements ont un effet immédiat sur la base d’utilisateurs locaux. Si la liste des utilisateurs est mo-
difiée en dehors de UserDrake, vous pouvez relire la nouvelle configuration en cliquant sur le bouton Rafrâıchir.

Note : Si vous faites des modifications concernant un utilisateur connecté, ces changements ne seront effectifs qu’à la
prochaine connexion de celui-ci.

Les actions disponibles sont :

Ajouter utilisateur

Ajoute un nouvel utilisateur au système. Nous détaillons la procédure dans Ajout d’un nouvel utilisateur,
page 86

Ajouter groupe

Ajoute un nouveau groupe d’utilisateurs au système.

Éditer

Permet de modifier les paramètres de l’utilisateur ou du groupe sélectionné. Nous détaillons les paramè-
tres utilisateur dans Ajout d’un nouvel utilisateur, page 86. Dans le cas d’un groupe, vous pourrez ajouter
ou supprimer des utilisateurs appartenant à ce groupe.

Supprimer

Supprime du système l’utilisateur ou le groupe sélectionné. Un message de confirmation s’affiche et dans
le cas d’un utilisateur, vous pourrez choisir de supprimer aussi son répertoire personnel /home ainsi que
sa boîte aux lettres.

8.5.2. Ajout d’un nouvel utilisateur

Lors de l’installation, nous avons créé l’utilisateur standard Reine Pingusa, et maintenant nous voulons créer
un nouvel utilisateur, Pierre Pingus. Puis, nous désirons les associer au groupe fileshare (partage de fi-
chiers) afin qu’ils puissent partager des dossiers sur le réseau avec d’autres utilisateurs .

Cliquez sur le bouton Ajouter utilisateur pour ajouter un nouvel utilisateur (figure 8-6). Le seul champ obliga-
toire est Utilisateur même si nous vous recommandons fortement d’assigner un mot de passe à cet utilisateur :
remplissez les champs Mot de passe et Confirmation du mot de passe. Vous pouvez aussi ajouter un commentaire
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dans le champ Nom complet. Généralement, c’est le nom complet de l’utilisateur, mais vous pouvez entrer ce
que vous voulez.

Figure 8-6. Ajout d’un nouvel utilisateur au système

Notre liste contient maintenant deux utilisateurs. Sélectionnez l’un des deux par un simple clic de souris, puis
cliquez sur le bouton Éditer. La fenêtre d’attributs figure 8-7 s’affichera. Elle vous permet de modifier la plupart
des paramètres de l’utilisateur.

Figure 8-7. Affectation des utilisateurs à un groupe

La fenêtre est composée des onglets suivants :

Données utilisateur

Permet de modifier les informations fournies lors de la création du compte utilisateur.

Info sur le compte

Permet d’entrer une date d’expiration du compte au delà de laquelle l’utilisateur ne peut plus se con-
necter, utile pour les comptes temporaires. Il est aussi possible de verrouiller temporairement un compte
afin d’empêcher un utilisateur de se connecter. Cet onglet vous permet aussi de changer l’icône associée
à l’utilisateur.

Information sur le mot de passe

Permet d’entrer un délai d’expiration du mot de passe au delà duquel l’utilisateur devra changer de mot
de passe.
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Groupes

Affiche la liste des groupes disponibles et permet de sélectionner les groupes auxquels l’utilisateur peut
appartenir.

Pour revenir à l’exemple de nos deux utilisateurs, il suffit de rechercher l’entrée fileshare et de la sélection-
ner. Cliquez sur le bouton OK pour rendre vos modifications effectives.

8.6. Sauvegarde et restauration de fichiers

Cet outil vous permet de sauvegarder les données présentes sur votre ordinateur sur différents
supports, et sur une machine distante d’un réseau. Il gère les profils multiples pour différents
scénarios de sauvegarde. Une fois les paramètres définis, des sauvegardes peuvent être faites
périodiquement. Vous pouvez alors l’oublier jusqu’à ce que vous souhaitiez restaurer des fi-
chiers.

8.6.1. Exemple concret avec l’assistant

Démarrez Drakbackup en cliquant sur l’icône Sauvegardes de la section Système de Centre de contrôle Mandriva
Linux. Lancez l’assistant en cliquant sur Configuration par assistant. Cliquez sur Suivant après chaque étape.

8.6.1.1. Première étape : que sauvegarder

Figure 8-8. Sélection des fichiers

Choisissez Sauvegarder le système pour inclure le dossier /etc. Tous les fichiers de configuration de votre
système s’y trouvent. Sélectionner cette option permet de reproduire facilement votre système sur un autre
ordinateur. Seuls les fichiers de configuration relatifs au matériel devront être mis à jour.

Note : La sauvegarde du système n’inclut pas les applications (exécutables et bibliothèque) car vous avez probablement
accès aux médias d’installation du système. Vous pouvez donc facilement réinstaller les programmes sur l’ordinateur cible.
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Sélectionnez Sauvegarder les comptes utilisateurs pour inclure tous les fichiers présents dans les répertoires
/home. Sinon, cliquez sur Sélectionner individuellement les utilisateurs et vous aurez également les options sui-
vantes :

• Ne pas inclure le cache du navigateur. Nous vous recommandons de choisir cette option en raison de la nature
même du cache des navigateurs, qui change en permanence.

• Utiliser des sauvegardes différentielles/incrémentales. Sélectionner cette option n’effacera pas les anciennes sau-
vegardes. Utiliser des sauvegardes incrémentales permettra de ne sauvegarder que les fichiers qui ont été mo-
difiés ou ajoutés depuis la dernière sauvegarde. Utiliser des sauvegardes différentielles permettra de ne sau-
vegarder que les fichiers qui ont été modifiés/ajoutés depuis la première sauvegarde (aussi connue comme
la sauvegarde de « base »). Cette option requiert plus d’espace que la première. Elle permet cependant de
restaurer le système dans l’état dans lequel il était lors de chaque opération de sauvegarde différentielle.

8.6.1.2. Deuxième étape : où stocker la sauvegarde

Figure 8-9. Sélection de l’emplacement de la copie de sauvegarde

Tous les médias de sauvegarde possibles sont listés et associés à un bouton Configurer permettant de changer
des options dépendant du média choisi :

Disque dur

Le disque dur local est utilisé pour préparer les sauvegardes pour tous les médias sauf pour NFS et les
sauvegardes directement sur bande. Vous ne devriez pas faire de sauvegarde sur votre disque dur local
de toute façon, vous devriez toujours faire vos sauvegardes sur des médias distants ou amovibles. Vous
pouvez définir le répertoire de stockage et limiter son espace. Vous pouvez aussi fixer le nombre de jours
pendant lesquels les sauvegardes incrémentales et différentielles seront conservées, afin d’économiser de
l’espace disque.

Par réseau

Pour stocker la sauvegarde sur un ordinateur distant accessible de plusieurs façons. Vous pouvez régler
les paramètres de connexion ainsi que la méthode d’accès et ses options (si disponibles). Notez que les
sauvegardes NFS sont considérées comme des sauvegardes sur disque local même si elles sont effective-
ment stockées sur un système distant.
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Sur lecteur de Bande

Vous pouvez régler le périphérique de bande s’il n’est pas détecté automatiquement ainsi que les paramè-
tres de la bande tels que l’écriture directe sur la bande, rembobiner la bande ou non, supprimer et éjecter
la bande.

Sur CD-R

C’est le média que nous avons choisi dans notre exemple. Cliquez sur le bouton Configurer pour régler les
paramètres requis (voir figure 8-10).

Figure 8-10. Paramétrage des médias optiques

Si le périphérique n’est pas automatiquement configuré, utilisez la liste déroulante Choisissez votre lecteur
CD/DVD. Réglez le type et la taille du média ainsi que les options de multisession et d’effacement.

Pour les enregistrements multisessions, gardez à l’esprit que l’option qui permet d’effacer un support n’est
effective que lors de la première session et que l’information relative à la session nécessite de l’espace (environ
20 à 30 Mo pour chaque session). Donc, l’espace de stockage disponible pour les données de sauvegarde sera
inférieur à la taille du support.
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8.6.1.3. Troisième étape : résumé et enregistrement des paramètres de configuration

Figure 8-11. Configuration de sauvegarde

La dernière étape de l’assistant montre un résumé des paramètres de configuration. Utilisez le bouton Précé-
dent pour modifier les paramètres dont vous n’êtes pas satisfait. Cliquez sur Enregistrer pour les stocker dans
le profil Défaut. Le jeu de sauvegarde est maintenant prêt à être exécuté.

Profils de sauvegarde

Vous pouvez cliquer sur le menu Fichier→Enregistrer le profil sous et saisir un nom de profil pour stocker les
paramètres de sauvegarde actuels dans un profil de sauvegarde qui portera le nom que vous avez saisi. Vous
pouvez ensuite relancer l’assistant de configuration, définir d’autres paramètres et les stocker dans un profil
différent.

Utilisez l’option --profile Nom_du_Profil.conf quand vous exécutez Drakbackup en ligne de com-
mande pour charger le profil Nom_du_Profil.conf.

8.6.1.4. Effectuer la sauvegarde

Cliquez sur le bouton Sauvegarder, assurez-vous que le support correspondant est prêt (le CD réinscriptible
dans notre exemple), puis cliquez sur le bouton Sauvegarder à partir de la configuration définie.

Avertissement

Si la taille de la sauvegarde dépasse la capacité du support, l’opération de sauvegarde pourrait échouer. Tentez de
retirer des fichiers de la liste de sauvegarde de manière à ne jamais excéder la capacité du support.

Une fenêtre affichant la progression de l’opération s’affiche. Soyez patient : le temps nécessaire à la sauvegarde
dépend de nombreux facteurs tels que la taille des fichiers à sauvegarder, ou la vitesse du média de stockage.
Une fois la sauvegarde effectuée, un résumé s’affiche. Recherchez-y les erreurs éventuelles et corrigez-les.
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8.6.2. Restauration des sauvegardes

Figure 8-12. Choix du type de restauration à effectuer

Assurez-vous que le support contenant la sauvegarde à restaurer est prêt et accessible. Cliquez sur Restaurer.
Dans notre exemple, nous restaurons l’intégralité de la sauvegarde. Dans la fenêtre de restauration (figure
8-12), cliquez sur Restaurer toutes les sauvegardes puis sur Restaurer pour démarrer la restauration.

Avertissement

Les fichiers existants dans le dossier où la restauration aura lieu seront écrasés. Par défaut, ce dossier est le même
que celui utilisé lors de la sauvegarde.

N’hésitez pas à explorez les autres options de restauration si vous souhaitez ne restaurer qu’une partie d’une
sauvegarde plutôt que tout l’ensemble de fichiers, ou restaurer la sauvegarde à un autre endroit.

8.6.3. Automatisation des sauvegardes périodiques

Dans la fenêtre principale, cliquez sur Configuration manuelle puis sur Quand. Dans la fenêtre de programma-
tion des sauvegardes (figure 8-13) choisissez Sauvegarde périodique pour définir la fréquence de la sauvegarde.

92



Chapitre 8. Personnalisation de votre système

Figure 8-13. Paramètres du robot

Vous devez alors spécifier l’intervalle (ou la période) entre chaque opération de sauvegarde ainsi que les sup-
ports de stockage. Dans notre exemple, nous avons défini un calendrier personnalisé (personnalisé sélectionné)
pour effectuer une sauvegarde du mercredi au vendredi à 23 heures 45 minutes, sur un CD, en utilisant le
profil de sauvegarde Défaut.

8.6.4. Configuration avancée des sauvegardes

Cliquez sur le bouton Configuration manuelle puis sur le bouton Plus d’options pour régler des options supplé-
mentaires (figure 8-14).

Figure 8-14. Options diverses

Programme d’Archivage

Vous avez le choix entre tar (choix par défaut) et star qui vous permet de sauvegarder aussi les ACL
étendues.
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Type de compression

Pour la stratégie de compression à utiliser lors de vos sauvegardes, vous avez le choix parmi : tar (aucune
compression), tar.gz (compression gzip) et tar.bz2 (compression bzip2: plus efficace mais plus
lent).

Fichiers à ignorer

Certains fichiers peuvent être exclus de la sauvegarde. Les fichiers .backupignore doivent être présents
dans chaque dossier où des fichiers doivent être exclus de la sauvegarde. Sa syntaxe est très simple : le
nom de chaque fichier devant être exclu doit y être présent (un nom de fichier par ligne).

Astuce : Vous pouvez utiliser une étoile (* signifie toute châıne de caractère ) et un point d’interrogation (?
signifie un, et un seul caractère, quel qu’il soit ) dans le fichier .backupignore pour exclure plusieurs fichiers. Par
exemple, abc* correspondra à tous les fichiers commençant par abc. image00?.jpg correspondra aux fichiers
nommés image001.jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.

Envoi de rapports par courriel

Indiquez l’adresse de courriel à laquelle un rapport de l’opération sera envoyé. Vous pouvez indiquer plu-
sieurs adresses de courriels séparées par une virgule (,). Remplissez aussi le champ Adresse de l’émetteur
du courriel avec l’adresse de l’administrateur des sauvegardes ainsi que le champ Serveur SMTP pour le
courrier avec le nom ou l’adresse IP du serveur de courriers sortants.

Suppression des fichiers temporaires

Cochez l’option Effacer les fichiers tar après sauvegarde vers un autre support pour libérer cet espace après
la sauvegarde.

Visualiser le journal de restauration

Vous pouvez visualiser le journal de restauration après chaque restauration. Cela peut être utile pour
identifier et réparer les problèmes qui peuvent éventuellement survenir lors d’une restauration de
fichiers : erreurs de lecture, erreurs de communication réseau, etc.
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9.1. DrakFirewall : configuration d’un pare-feu élémentaire

Cet assistant vous guidera à travers le processus de configuration d’un pare-feu sur votre ma-
chine. Il filtrera les tentatives de connexions extérieures, et bloquera celles qui ne seront pas
autorisées. Il est recommandé de le lancer juste après l’installation de votre système et avant
de vous connecter à Internet, ce qui minimisera les risques d’intrusion sur votre machine.

Cet assistant comporte plusieurs étapes que nous détaillons ci-dessous.

9.1.1. Choisissez les services accessibles depuis l’extérieur

Figure 9-1. La boîte de dialogue de DrakFirewall

Ouvrez les ports, si nécessaire. Si elle est cochée, décochez la case Tout (pas de firewall), puis cochez les cases
correspondant aux services que vous souhaitez rendre disponibles pour le monde extérieur. Si vous souhaitez
autoriser un service qui n’est pas listé ici, cliquez sur le bouton Avancé pour pouvoir entrer manuellement le
numéro de port à ouvrir.

Ouverture de services peu communs : La section Avancé va rajouter un champ Autres ports dans lequel vous pourrez
rentrer n’importe quel port que vous souhaitez laisser ouvert pour l’extérieur. Des exemples de spécifications de tels ports
sont affichés juste au-dessus. Il est aussi possible de spécifier une plage de ports à l’aide de la syntaxe : par exemple :
24300:24350/udp

Cela ne vous empêchera pas d’accéder à Internet. Le fait de ne pas cocher un service de cette liste ne vous
empêchera pas de vous y connecter. Par contre, les utilisateurs externes ne pourront pas se connecter à ce
service sur votre machine. Si vous pensez n’héberger aucun service sur votre machine (cas le plus courant
pour une simple machine de bureau), décochez toutes les cases.

Comment désactiver le pare-feu. D’un autre côté, si vous souhaitez désactiver le pare-feu et laisser ouvert
l’accès à tous les services depuis l’extérieur, cochez Tout (pas de firewall), mais gardez à l’esprit que cela est
très dangereux, et par conséquent déconseillé.
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9.1.2. Activez le pare-feu interactif

Figure 9-2. Options du pare-feu interactif

Soyez informé des tentatives de connexion à votre machine.

Le pare-feu interactif peut vous avertir des tentatives de connexion à votre machine, en affichant un message
d’alerte avec l’applet du réseau. Cochez l’option Utiliser le Pare Feu interactif pour activer cette fonction.

Détection de balayage de ports

Activez cette option pour être averti des tentatives d’accès malveillantes à votre machine.

Autres entrées correspondant aux ports ouverts

Ensuite, une case apparaît près des ports que vous avez choisi d’ouvrir à l’étape précédente. Si vous les
activer, un message d’avertissement apparaîtra chaque fois qu’une tentative de connexion sera effectuée
sur ces ports.

9.1.3. Quelle interface protéger

L’étape suivante consiste à choisir l’interface réseau connectée à Internet.
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Figure 9-3. L’interface Internet

Si vous ne savez pas laquelle de vos interfaces est connectée à Internet, vous pouvez jeter un oeil à la confi-
guration réseau du système (Reconfiguration d’une interface, page 75). Enfin, cliquez sur OK pour installer les
paquetages nécessaires, activez le pare-feu et appréciez une connexion à Internet sécurisée.
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